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Section 1
Introduction

This manual describes the switch management tools which include the SANbox 
Manager® application and the Command Line Interface (CLI). These switch 
management tools support SANbox2 switches.

The SANbox Manager switch management application is the primary focus of this 
manual which is organized as follows:

■ Section 1 describes the intended audience for this manual, related 
materials, and technical support.

■ Section 2 describes how to use SANbox Manager, its menus, and its 
displays.

■ Section 3 describes fabric management tasks.

■ Section 4 describes switch management tasks.

■ Section 5 describes port and device management tasks.

■ Appendix A describes the Command Line Interface.

A glossary of terms and an index are also provided.

1.1

Intended Audience
This manual introduces QLogic switch management products and explains their 
installation and use. It is intended for users responsible for installing and using 
network management tools.

1.2

Related Materials
Refer to the following manual for switch hardware and installation information:

■ SANbox2-16 Fibre Channel Switch Installation Guide, publication number 
59021-03.

■ SANbox2-8c Fibre Channel Switch Installation Guide, publication number 
59042-00.
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1.3

Technical Support
Customers should contact their authorized maintenance provider for technical 
support of their QLogic switch products. QLogic-direct customers may contact 
QLogic Technical Support; others will be redirected to their authorized 
maintenance provider.

Visit the QLogic switch support Web site listed in 1.3.3 Contact Information for the 
latest firmware and software updates.

1.3.1

Availability
QLogic Technical Support is available from 7:00 AM to 7:00 PM Central Standard 
Time, Monday through Friday, excluding QLogic-observed holidays.

1.3.2

Training
QLogic offers the following technical training courses:

■ Switch Certification

■ HBA Certification

Each course is available at the training facility in Eden Prairie, MN or at your local 
facility. All courses include a Fibre Channel overview and sections on installation, 
maintenance, and topology solutions. Each student receives a set of manuals and 
a CD-ROM containing course training materials. Upon successful completion of 
the training, QLogic awards a certificate identifying the student as a Certified 
SANbox™ or SANblade™ Professional.

1.3.3

Contact Information

Address: QLogic Switch Products Inc.
6321 Bury Drive
Eden Prairie, Minnesota 55346
USA

Telephone: +1 952-932-4040

Fax: +1 952-932-4018

Email:
Technical Service
Technical Training

support@qlogic.com
tech.training@qlogic.com

Switch Support Web Site: www.qlogic.com/support/home_support.asp

http://www.qlogic.com/support/home_support.asp
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Section 2
Using SANbox Manager

This section describes how to use the SANbox Manager application and its 
menus. The following topics are covered:

■ Installing SANbox Manager

■ Starting SANbox Manager

■ Exiting SANbox Manager

■ Changing the password for the default fabric view file

■ Setting SANbox Manager user preferences

■ Using online help

■ SANbox Manager user interface

■ Using the topology display

■ Using the faceplate display

2.1

Installing SANbox Manager
The SANbox Manager application requires a management workstation with the 
following characteristics:

Table 2-1. Management Workstation Requirements

Operating System ■ Windows® NT, 2000, 95/98
■ Linux® 6.2 Red Hat
■ Solaris™

Memory 128 MB or more

Disk Space 150 MB per installation

Processor 300 MHz or faster

Hardware CD-ROM drive, RS-232 port, 10/100 Base-T Ethernet port

Internet Browser Microsoft® Internet Explorer® or Netscape Navigator®
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2.1.1

For Windows: 
To install the SANbox Manager application on Windows from the SANsurfer® Tool 
Kit CD-ROM, do the following:

1. Close all programs currently running, and Insert the SANsurfer Tool Kit 
CD into the management workstation CD-ROM drive. If the SANsurfer 
Tool Kit start page does not open in your default browser, do the 
following:

a. Using Windows Explorer, double-click the drive letter which 
contains the SANsurfer Took Kit CD. 

b. Locate and double-click the Start_Here.htm file to open the 
SANsurfer Tool Kit start page in your default browser.

2. On the SANsurfer Tool Kit start page, choose the SANbox Switch 
Software button.

3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) 
Series area. 

4. In the Windows column, choose the SANbox Manager link to open the 
File Download window.

5. You have a choice of running the installation file from the CD-ROM or 
downloading the installation file to your hard drive. Choose one of the 
following:

■ Open the installation file from the CD-ROM and follow the 
SANbox Manager installation instructions. 

■ Specify a location in which to save the 
sansurfer_windows_install.exe file, and choose the Save 
button. Double-click the saved sansurfer_windows_install.exe 
file and follow the SANbox Manager installation instructions.
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2.1.2

For Linux:
To install the SANbox Manager application on Linux from the SANsurfer Tool Kit 
CD-ROM, do the following:

1. Close all programs currently running, and insert the SANsurfer Tool Kit 
CD into the management workstation CD-ROM drive. If a file browser 
window opens showing icons for the contents of the CD-ROM, 
double-click the Start_Here.htm file to open the SANsurfer Tool Kit 
start page. If a file browser does not open, double-click the CD-ROM 
icon on the to open the browser. If there is no CD-ROM icon on the, do 
the following:

a. Open an xterm or other terminal window.

b. Mount the CD-ROM. From a shell prompt, enter the following 
command:

mount /mnt/cdrom

c. Execute your web browser to view the Start_Here.htm 
document using one of the following commands:

$mozilla file:/mnt/cdrom/Start_Here.htm

or

$netscape file:/mnt/cdrom/Start_Here.htm

d. The SANsurfer Tool Kit start page opens in your default browser.

2. On the SANsurfer Tool Kit start page, choose the SANbox Switch 
Software button.

3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) 
Series area. 

4. In the Linux column, choose the SANbox Manager link to open the 
Save As window.

5. Enter a path name to save the sansurfer_linux_install.bin file, and 
choose the Save button.

6. Open a terminal window for the directory in which the 
sansurfer_linux_install.bin file was saved, and enter the following 
command: 

chmod +x sansurfer_linux_install.bin

7. Press the Enter key.

8. Enter the following command:

./sansurfer_linux_install.bin

9. Press the Enter key, and follow the SANbox Manager installation 
instructions.
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2.1.3

For Solaris:
To install the SANbox Manager application on Solaris from the SANsurfer Tool Kit 
CD-ROM, do the following:

1. Close all programs currently running, and insert the SANsurfer Tool Kit 
CD into the management workstation CD-ROM drive. If the SANsurfer 
Tool Kit start page does not open in your default browser, do the 
following: 

a. Right-click the to open the Workspace Menu.

b. Point to and select Files, then select File Manager.

c. In File Manager, double-click the CD-ROM icon, and then 
double-click the Sansurfer folder.

d. In the Sansurfer folder, double-click the Start_Here.htm file to 
open the SANsurfer Tool Kit start page in your default browser.

2. On the SANsurfer Tool Kit start page, choose the SANbox Switch 
Software button.

3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) 
Series area.

4. In the Solaris column, choose the SANbox Manager link to open the 
Save As window.

5. Enter a path name to save the sansurfer_solaris_install.bin file and 
choose the Save button.

6. Open a terminal window for the directory in which the 
sansurfer_solaris_install.bin file was saved, and enter the following 
command: 

chmod +x sansurfer_solaris_install.bin

7. Press the Enter key.

8. Enter the following command:

./sansurfer_solaris_install.bin

9. Press the Enter key, and follow the SANbox Manager installation 
instructions.

Note: If you download SANbox Manager from a server, be sure the 
downloaded file has execute permission before installing. 
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2.2

Starting SANbox Manager
To start the SANbox Manager application for the first time, choose one of the 
following, and press the Enter key:

■ For a Windows platform, double-click the SANbox Manager shortcut, or 
select SANbox Manager from Start menu, depending on how you installed 
the SANbox Manager application.

■ For a Linux platform, enter the following on the command line:

# /SANbox_Manager/SANbox_Manager

■ For a Solaris platform, enter the following on the command line:

/usr/opt/QLogic_Corporation/SANbox_Manager/SANbox_Manager

The SANbox Manager application opens with the display shown in Figure 2-1.

Figure 2-1.  SANbox Manager Window
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If the default fabric view file exists, the system prompts you to enter the file 
password as shown in Figure 2-2. Enter the password and choose the Load View 
File button to open the SANbox Manager application and load a previously saved 
set of fabrics. Otherwise, choose the Continue Without Loading button to open 
an empty fabric view. Choose Add button to open the Add a New Fabric window 
shown in Figure 2-3. 

Figure 2-2.  Load Default Fabric View File Window

To start using the SANbox Manager application, do the following to add a fabric:

1. Open the Fabric menu and select Add Fabric to open the Add a New Fabric 
window as shown in Figure 2-3.

Figure 2-3.  Add a New Fabric Window

2. Enter a fabric name and the IP address of the switch through which to 
manage the fabric.

3. Enter an account name and a password. The factory account name is 
"admin" and the factory password is "password". If security is turned off 
(default), you are not required to enter an account name or password. This 
password is for the switch and is stored in the switch firmware. Refer to the 
User Command on page A-59 for more information. 

4. Choose the Add Fabric button.
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2.3

Exiting SANbox Manager
When exiting SANbox Manager, the current fabric view is encrypted and saved to 
the default fabric view file (fc_view.dft). A password is required to encrypt and 
save the default fabric view file the first time you exit SANbox Manager. When you 
exit subsequent sessions, SANbox Manager closes and saves the default fabric 
view file automatically without having to enter a password. 

In your next session, SANbox Manager opens the default fabric view file 
automatically after entering its password. To prevent SANbox Manager from 
automatically saving the default fabric view file each time you exit SANbox 
Manager, set the View File Auto Save and Load preferences setting to Disable 
(Enable is the default). Refer to ”Setting Preferences” on page 2-9 for more 
information.

To exit a SANbox Manager application session, open the File menu and select 
Exit. The system prompts you to enter a password with which to protect the 
default fabric view file as shown in Figure 2-4. Choose one of the following:

■ Enter a password and choose the Save View File button to save the current 
set of fabrics in the default fabric view file (fc_view.dft) in the working 
directory.

■ Choose the Exit Without Saving button to exit the application without 
saving the current fabrics to the default fabric view file.

■ Choose the Cancel Exit button to cancel the exit operation.

Figure 2-4.  Save Current Fabric View Window

If the default fabric view file was saved with a password, the next time you open 
the SANbox Manager application, you will be prompted for the password in the 
Load Default Fabric View File window as shown in Figure 2-2. Your fabric opens 
after entering the password. 
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2.4

Uninstalling SANbox Manager 
A program to uninstall SANbox Manager was installed as part of the SANbox 
Manager installation process. The Uninstaller Data folder in the Install folder 
contains the uninstall program (Uninstall SANbox Manager). Also, a shortcut/link 
to the uninstall program was installed in the user’s home directory during the 
SANbox Manager installation process. The default installation directory is the 
user’s home directory /QLogic_Corporation/SANbox_Manager.

To uninstall the SANbox Manager application:

1. Browse for the uninstall program file or the shortcut/link that points to the 
uninstall program file. The uninstall program shortcut is in the same folder as 
the program shortcut (Start menu, program group, on, or user specified) that 
is used to start the SANbox Manager application.

2. Double-click the uninstall program file or shortcut/link, and follow the 
instructions to uninstall the SANbox Manager application.

2.5

Changing Default File Password
To change the password for the default fabric view file, do the following:

1. Open the File menu and select Change Default File Password to open the 
Set New Password window as shown in Figure 2-5.

Figure 2-5.  Set New Password Window

2. Enter the new password in the Default File Password field.

3. Re-enter the same password in the Re-enter Password to Confirm field.

4. Choose the OK button to save the changes.

Note: For UNIX uninstalls, execute the link to Uninstall_SANbox_Manager. If 
no links were created during the installation, run: 
$INSTALL_DIR/UninstallerData/Uninstall_SANbox_Manager. Where 
INSTALL_DIR is the directory selected for installation.
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2.6

Setting Preferences
Using the Preferences settings, you can:

■ Change the location of the working directory (user’s home directory is the 
default) used to save files

■ Change the location of the browser used to view the online help 

■ Choose the polling frequency. That is, how often the SANbox Manager 
application polls the fabric. Rapid (default) is the normal polling level, 
Intermediate is 1.5 times slower than the rapid level, and Slow is 2 times 
slower than rapid level.

■ Enable or disable the default view file auto save and load feature. Refer to 
”Starting SANbox Manager” on page 2-5 for more information on the default 
fabric view file. 

■ Choose the default port view when opening the faceplate display. Refer to 
”Monitoring Port Status” on page 5-2 for more information on port views.

Figure 2-6.  Preferences Window

To set user preferences for your SANbox Manager sessions, do the following: 

1. Open the File menu, and select Preferences to open the Preferences 
window.

2. Enter or browse for paths to the working directory and browser.

3. In the Application-wide Options area, choose the polling frequency, enable 
or disable the View File Auto Save and Load feature, and choose the initial 
port view when entering the faceplate display.

4. Choose the Apply button to save the changes.
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2.7

Using Online Help
Online help is available for the SANbox Manager application and its functions. 
The two ways to open the online help file are: open the Help menu and select 
Help Topics, or choose the Help button in the tool bar.

2.8

Viewing Software Version and Copyright Information
To view SANbox Manager software version and copyright information, open the 
Help menu and select About.... 



2 – Using SANbox Manager
SANbox Manager User Interface

59022-03 D 2-11

�

2.9

SANbox Manager User Interface
The SANbox Manager application uses two basic displays to manage the fabric 
and individual switches: the topology display and the faceplate display. The 
topology display shows all switches that are able to communicate and all 
connections between switches. The faceplate display shows the front of a single 
switch and its ports. Both displays share some common elements as shown in 
Figure 2-7.

Figure 2-7.  SANbox Manager Display Elements
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2.9.1

Menu Bar
The Menu Bar presents the SANbox Manager menus as shown in Figure 2-8. The 
menus and the tasks offered in them vary depending on the display. For example, 
the Port menu and many of the Switch menu selections appear only in the 
faceplate display. Menu items with a gray background. 

Figure 2-8.  SANbox Manager Menu Structure

Some menu selections have shortcut keys as shown in Table 2-2. 

In addition to the menu bar, both the topology and faceplate displays have context 
sensitive menus that pop up when you click in the graphic window with the right 
mouse button. Refer to ”Opening the Faceplate Display and Popup Menus” on 
page 2-17 for more information about these popup menus.

Table 2-2. Menu Shortcut Keys

Shortcut Key Menu Selection

F5 key View>Refresh

Ctrl+O File>Open View File

Delete
Export Name Server
Archive
Restore
Load Firmware 
Switch Properties
Network Properties
  Toggle Beacon
Export Alarm Log
Reset Switch
Restore Factory Defaults

Refresh
View Port Modes
View Port States
View Port Speeds
View Port Media 

Fabric

Add Fabric...
Remove Fabric
Rediscover Fabric

ViewZoning

PortFile

Open View File...
Save View As...
Change Default File Password
Preferences
Exit

Help

Help Topics
About...

Switch

Port Properties
Extended Credits
Reset Port
Port Loopback Test

Edit Zoning
Edit Zoning Config
Activate Zone Set
Deactivate Zone Set
Restore Default Zoning
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2.9.2

Tool Bar
The Tool Bar consists of a row of graphical buttons that you can use to access 
SANbox Manager functions as shown in Table 2-3. The tool bar buttons are an 
alternative method to using the menu bar.

Table 2-3. Tool Bar buttons

Tool Bar Button Description

Add Fabric button - adds a new a fabric. 

Open View File button - opens an existing fabric view file. 

Save View As button - saves the current fabric view to a file.

Refresh button - polls fabric to update topology or faceplate display 
with current information.

Help Topics button - opens the online help file.

Edit Zoning button - opens the Edit Zoning window (available only 
in faceplate display).
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2.9.3

Fabric Tree
The fabric tree lists the managed fabrics and their switches as shown in 
Figure 2-9. The window width can be adjusted by clicking and dragging the 
moveable window border. An entry handle located to the left of an entry in the tree 
indicates that the entry can be expanded. Click this handle or double-click the 
entry to expand or contract a fabric tree entry. A fabric entry expands to show its 
member switches.

Figure 2-9.  Fabric Tree

Each fabric tree entry has a small icon next to it that uses color to indicate 
operational status.

■ A green icon indicates normal operation.

■ A red icon indicates a communications failure.

■ A blue icon indicates that a switch is unknown, or a switch with security 
enabled when the fabric management switch has security disabled.

■ A yellow icon indicates that a switch is operational with errors.

The fabric tree provides access to the topology and faceplate displays for any 
fabric or switch.

■ To open the topology display from the fabric tree, click a fabric entry.

■ To open the faceplate display from the fabric tree, click a switch entry.
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2.9.4

Graphic Window
The graphic window presents graphic information about fabrics and switches such 
as the fabric topology and the switch faceplate. The window length can be 
adjusted by clicking and dragging the window border that it shares with the data 
window.

2.9.5

Data Window and Tabs
The data window presents a table of data and statistics associated with the 
selected tab. Use the scroll bar to browse through the data. The window length 
can be adjusted by clicking and dragging the border that it shares with the graphic 
window. 

Adjust the column width by moving the pointer over the column heading border 
shared by two columns until a right/left arrow graphic is displayed. Click and drag 
the arrow to the desired width.

The data window tabs present options for the type of information to display in the 
data window. These options vary depending on the display.

2.9.6

Working Status Indicator
The working status indicator, located in the lower right corner of SANbox Manager 
window, shows when the management workstation is exchanging information with 
the fabric. As conditions change, the fabric forwards this information to the 
management workstation where it is reflected in the various displays.
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2.10

Using the Topology Display
The topology display shown in Figure 2-10 polls the selected fabric and displays 
its topology. Switches and inter-switch links (ISL) appear in the graphic window 
and use color to indicate status. Consider the following features of the topology 
display:

■ Switch and link status

■ Working with switches and links

■ Topology data windows

Figure 2-10.  Topology Display

2.10.1

Switch and Link Status
Switch icon shape and color provide information about the switch and its 
operational state. Lines represent links between switches. The topology display 
uses green to indicate normal operation, yellow to indicate operational with errors, 
red to indicate inactive or failure, and blue to indicate unknown. Refer to ”Fabric 
Status” on page 3-6 for more information about topology display icons.
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2.10.2

Working with Switches and Links
Switch and link icons are selectable and moveable, and serve as access points for 
other displays and menus. You select switches and links to display information 
about them, modify their configuration, or delete them from the display. The 
context-sensitive popup menus are accessible through the switch and link icons.

2.10.2.1

Selecting Switches and Links
Selected switch icons are highlighted in violet. Selected ISLs are highlighted in 
yellow. You can select switches and links in the following ways. 

■ To select a switch or a link, click the icon or link.

■ To select multiple switches or links, hold down the Control key and select.

■ To select all switches or links, right-click in the graphic window background. 
Select Select All Switches or Select All Links from the popup menu.

To cancel a selection, press and hold the Control key, and select the item again. 
To cancel multiple selections, click in the graphic window background.

2.10.2.2

Moving a Switch in the Display
To move a switch icon, click and drag the icon to another location in the graphic 
window. Links stretch or contract to remain connected.

2.10.2.3

Opening the Faceplate Display and Popup Menus
The faceplate display shows the front of a single switch and its ports. 

■ To open the faceplate display when viewing the topology display, click the 
switch entry/icon in the fabric tree, or double-click the switch graphic.

■ To open the fabric popup menu when viewing the topology display, right-click 
the graphic window background. The fabric popup menu presents selections 
to refresh the fabric, select all switches, select all links, or layout topology.

■ To open the switch popup menu when viewing the topology display, 
right-click the switch icon in the graphic window. The switch popup menu 
presents selections to refresh the switch, delete the switch from the display, 
open the Switch Properties window, or open the Network Properties window.

■ To open the link popup menu, right-click the link. The Link popup menu 
presents a selection to delete the link from the display.

■ To open a faceplate display popup menu, right-click the faceplate graphic in 
the graphic window. The faceplate popup menu presents selections to 
refresh the switch, select all ports, manage switch, port, and network 
properties, extend credits, and run the Port Loopback tests.
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2.10.3

Topology Data Windows
The topology display provides the following data windows corresponding to the 
data window tabs:

■ Name Server - displays all devices logged with the name server and their 
location within the current fabric configuration. Refer to ”Name Server Data 
Window” on page 4-3 for more information.

■ Active Zoneset - displays the active zone set for the fabric including zones 
and their member ports. Refer to ”Active Zone Set Data Window” on 
page 3-8 for more information about this data window. Refer to ”Zoning a 
Fabric” on page 3-9 for information about zone sets and zones.

■ Switch - displays current network and switch configuration data for the 
selected switches. Refer to ”Switch Data Window” on page 4-4 for more 
information.

2.11

Using the Faceplate Display
The faceplate display shown in Figure 2-11 displays the switch name and 
operational state, and port status. Consider the following functional elements of 
the faceplate display:

■ Port views and status

■ Working with ports

■ Faceplate data windows

Figure 2-11.  Faceplate Display
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2.11.1

Port Views and Status
Port color and text provides information about the port and its operational state. 
Green indicates active; gray indicates inactive. The faceplate display provides the 
following views of port status corresponding to the View menu options in the 
faceplate display. Refer to ”Monitoring Port Status” on page 5-2 for more 
information about these displays.

■ Port mode

■ Port state

■ Port speed

■ Port media

2.11.2

Working with Ports
Ports are selectable and serve as access points for other displays and menus. 
You select ports to display information about them in the data window or to modify 
them. Context sensitive popup menus and properties windows are accessible 
through the faceplate and port icons.

2.11.2.1

Selecting Ports
You can select ports in the following ways. Selected ports are highlighted with a 
white border.

■ To select a port, click the port in the faceplate display.

■ To select a range of consecutive ports, select a port, then press and hold the 
shift key and select another port. The application selects both end ports and 
all ports in between in port number sequence.

■ To select several non-consecutive ports, hold the Control key while 
selecting.

■ To select all ports, right-click anywhere in the graphic window. Select Select 
All Ports from the popup menu.

To cancel a selection, press and hold the Control key and select it again.
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2.11.2.2

Opening Popup Menus
Using the right mouse button, you can open the faceplate popup menu. This 
popup menu presents several selections to manage the switch and its ports.

■ To open the popup menu, right-click anywhere in the graphic window. If no 
ports are selected, port specific tasks will be unavailable in the menu.

■ To select one or more ports and open the Port popup menu, right-click a 
port.

2.11.3

Faceplate Data Windows
The faceplate display provides the following data windows corresponding to the 
data window tabs:

■ Name Server - displays all devices connected to the switch that are logged 
with the name server.

■ Switch - displays current switch configuration data.

■ Port Statistics - displays port performance data for the selected port(s).

■ Port Information - displays port detail information for the selected port.

■ Configured Zonesets - displays all zone sets, zones, and zone membership 
in the zoning database.

■ Alarm Log - displays the system error information.
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Section 3
Managing Fabrics

This section describes the following tasks that manage fabrics:

■ Security

■ Managing the fabric database

■ Displaying fabric information

■ Zoning a fabric

3.1

Security
The two components of SANbox2 security are user authentication and fabric 
security. The user must be authenticated before gaining access to a switch. If an 
invalid account name/password combination is entered, that user can not access 
the switch, and thus can not gain access to the fabric. If security is enabled (on) 
and a valid account name/password combination is entered, that user can access 
the switch but can not execute any command that exceeds their authority 
(privileges) level. If security is disabled (off) and a valid account name/password 
combination is entered, that user has access to all switches in the fabric and can 
execute all commands (both user and admin), regardless of their authority 
(privileges) level.

3.1.1

User Authentication
User authentication pertains to accessing a switch based on a valid account 
name/password combination entered by the user. The valid account 
name/password/system privileges combinations are set up by the system 
administrator, and define which set of system commands each user may execute 
if a valid account name/password combination is entered. The system privileges 
are tied to the account name/password combination. 

3.1.2

Fabric Security
Fabric security pertains to whether all switches in the fabric are configured to 
permit access to each switch in that fabric. All switches in the fabric should be 
configured with the same security setting (enabled/true or disabled/false). By 
default, security is disabled. Once access is gained to the entry switch in a fabric, 
that user may access all switches in that fabric. 
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3.2

Managing the Fabric Database
A fabric database contains the set of fabrics that you have added during a 
SANbox Manager session. Initially, the SANbox Manager application opens with 
an empty fabric database. 

3.2.1

Adding a Fabric
To add a fabric to the database, do the following:

1. Open the Fabric menu and select Add Fabric to open the Add a New Fabric 
window as shown in Figure 3-1.

Figure 3-1.  Add a New Fabric Window

2. Enter a fabric name and the IP address of the switch through which to 
manage the fabric.

3. Enter an account name. The factory account name and password are 
(admin, password). Choose the Add Fabric button.

This password is for the switch and is stored in the switch firmware. If 
security is turned off (default), you are not required to enter an account 
name or password. Refer to ”Security” on page 3-1. Refer to the Set Setup 
Command on page A-34 for account name, password, and security 
information.

Note: A switch supports a combined maximum of 15 logins. This includes 
SANbox Manager inband and out-of-band logins, Telnet out-of-band 
logins, and SNMP out-of-band logins. Additional logins will be refused.



3 – Managing Fabrics
Managing the Fabric Database

59022-03 D 3-3

�

3.2.2

Removing a Fabric
To delete a fabric file from the database, do the following:

1. Select a fabric in the fabric tree.

2. Open the Fabric menu and select Remove Fabric.

3.2.3

Opening a Fabric View File
To open an existing view file, do the following:

1. Open the File menu, and select Open View File, or choose the Open 
button. If the fabric you are currently has changed, you will be prompted to 
save the changes to the view file before opening a different view file.

2. In the Open View window, enter the name of the file to open.

3. Enter a file password, if necessary. 

4. Choose the Load View File button. If the fabric has changed, you will be 
prompted to save before opening the new view. 

3.2.4

Saving a Fabric View File
To save a view file, do the following:

1. Open the File menu, and select Save View As. 

2. In the Save View window, enter a new file name.

3. Enter a file password, if necessary. 

4. Choose the OK button.

3.2.5

Rediscovering a Fabric
After making changes to or deleting switches from a fabric view, it may be helpful 
to again view the actual fabric configuration. The rediscover fabric option clears 
out the current fabric information being displayed, and rediscovers all switch 
information. To rediscover a fabric, open the Fabric menu, and select Rediscover 
Fabric. 
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3.2.6

Adding a New Switch to a Fabric 
If there are no special conditions to be configured for the new switch, simply plug 
in the switch and the switch becomes functional with the default fabric 
configuration. The default fabric configuration settings are:

■ Fabric zoning is sent to the switch from the fabric.

■ All ports will be GL_Ports.

■ The default IP address 10.0.0.1 is assigned to the switch without a gateway 
or boot protocol configured (RARP, BOOTP, and DHCP).

If you are adding a new switch to a fabric and do not want to accept the default 
fabric configuration, do the following: 

1. If the switch is not new, reset the switch to factory configuration before 
adding the switch to the fabric using the Restore Factory Defaults option in 
the Switch menu. 

2. If you want to manage the switch through the Ethernet port, you must first 
configure the network SNMP configuration using the Network Properties 
window.

3. Configure any special switch settings (default visibility, broadcast support, 
and orphan zone behavior). We suggest configuring Default Visibility setting 
to None in the Zoning Config window to prevent communication with other 
switches in the fabric until the new switch is configured.

4. Plug in the inter-switch links (ISL), but do not connect the devices. 

5. Configure the port types for the new switch (GL_Port, TL_Port, Donor) using 
the Port Properties window. 

6. Connect the devices to the switch.

7. Make any necessary zoning changes using the Edit Zoning window. 



3 – Managing Fabrics
Displaying Fabric Information

59022-03 D 3-5

�

3.2.7

Replacing a Failed Switch in a Fabric
To replace a failed switch in a fabric, plug in the switch and copy the archived 
switch configuration file to the switch using the Restore function. Refer to 
”Restoring a Switch” on page 4-16 and ”Archiving a Switch” on page 4-15 for more 
information. The switch configuration must be archived before it can be restored. 

To replace a failed switch using the SANbox Manager Restore function: 

1. Unplug and remove the failed switch.

2. Plug in the new replacement switch. 

3. Open the topology display and select the replacement switch.

4. Open the Switch menu and select Restore.

5. In the Restore Switch window, enter a name or choose the archived switch 
configuration file to copy to the switch.

6. Choose the OK button to write the configuration file to the switch.

3.2.8

Deleting Switches and Links
The SANbox Manager application does not automatically delete switches or links 
that have failed or have been physically removed from the Fibre Channel network. 
In these cases, you can delete switches and links to bring the display up to date. If 
you delete a switch or a link that is still active, the SANbox Manager application 
will restore it automatically. You can also refresh the display. To delete a switch 
from the topology display, do the following:

1. Select one or more switches in the topology display.

2. Open the Switch menu and select Delete.

To delete a link, do the following:

1. Select one or more links in the topology display.

2. Open the Switch menu and select Delete.

3.3

Displaying Fabric Information
The topology display is your primary tool for monitoring a fabric. The graphics 
window of the topology display provides status information for switches, 
inter-switch links, and the Ethernet connection to the management workstation.

The data window tabs show name server, switch, and active zone set information. 
The Active Zoneset tab shows the zone definitions for the active zone set. Refer 
to ”Name Server Data Window” on page 4-3 and ”Switch Data Window” on 
page 4-4 for information about the Name Server and Switch data windows.
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3.3.1

Fabric Status
The fabric updates the topology and faceplate displays by forwarding changes in 
status to the management workstation as they occur. You can allow the fabric to 
update the display status, or you can refresh the display at any time. To refresh 
the topology display, do one of the following:

■ Choose the Refresh button.

■ Open the View menu and select Refresh.

■ Press the F5 key.

■ Right-click anywhere in the background of the topology display and select 
Refresh Fabric from the popup menu.

The topology display uses switch and status icons to provide status information 
about switches, inter-switch links, and the Ethernet connection. The switch icons 
indicate 16 port switch or an unknown switch type. The switch status icons, 
displayed on the left side of a switch, vary in shape and color. Switches controlled 
by an Ethernet Internet Protocol have a colored Ethernet icon displayed on the 
right side of the switch. A green Ethernet icon indicates normal operation, yellow 
indicates operational with errors, and red indicates inactive or failure. Table 3-1 
shows the different switch icons and their meanings.

Table 3-1. Topology Display Switch and Status Icons 

Switch Icon Description

SANbox2 Switch
Normal operation (Green)

SANbox2-8c Switch
Normal operation (Green)

Non-QLogic Switch, or a QLogic Switch with different 
security than the fabric management switch.

Switch communication normal (Green)

Switch is operational with errors (Yellow)
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Switch communication interrupted (Red)

Switch management communication unknown (Blue)

Fabric Management Switch
Ethernet connection normal (Green)

Fabric Management Switch
Ethernet connection critical (Red)

Fabric Management Switch
Ethernet connection warning (Yellow)

Table 3-1. Topology Display Switch and Status Icons (Continued)

Switch Icon Description
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3.3.2

Active Zone Set Data Window
The Active Zoneset data window displays the zone membership for the active 
zone set. To open the Active Zoneset data window, choose the Active Zoneset 
tab below the data window in the topology display. Refer to ”Configured Zonesets 
Data Window” on page 4-6 for information about the zone set definitions on a 
particular switch. Refer to ”Zoning a Fabric” on page 3-9 for more information 
about zone sets and zones.

The Active Zoneset data window, shown in Figure 3-2, uses display conventions 
for expanding and contracting entries that are similar to the fabric tree. An entry 
handle located to the left of an entry in the tree indicates that the entry can be 
expanded. Click this handle or double-click the following entries to expand or 
contract them:

■ A zone set entry expands to show its member zones.

■ A zone entry expands to show its member ports.

■ A port entry expands to show the port Fibre Channel address.

■ A Fibre Channel address entry expands to show the port worldwide name.

Figure 3-2.  Active Zone Set Data Window

Active Zoneset 
Data Window
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3.4

Zoning a Fabric
Zoning enables you to divide the ports and devices of the fabric into zones for 
more efficient and secure communication among functionally grouped nodes. This 
subsection addresses the following topics:

■ Zoning concepts

■ Using the Zoning Config window

■ Restoring default zoning

■ Merging fabrics and zoning

■ Using the Edit Zoning window

■ Managing zone sets

■ Managing zones

■ Managing aliases

3.4.1

Zoning Concepts
The following zoning concepts provide some context for the zoning tasks 
described in this section:

■ Zones

■ Aliases

■ Zone sets

■ Zoning database

■ Zoning configuration
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3.4.1.1

Zones
A zone is a named group of ports or devices that can communicate with each 
other. Membership in a zone can be defined by port number, device Fibre 
Channel address, or device World Wide Name (WWN). Zone members can 
communicate only with members of the same zone. Zones can overlap; that is, a 
port or device can be a member of more than one zone.

Three types of zones are supported. The following zone types define increasing 
restrictive levels of communication. 

■ Soft zone

■ Access Control List (ACL) - hard zone

■ Virtual Private Fabric (VPF) - hard zone

3.4.1.1.1

Soft Zones
Soft zoning divides the fabric for purposes of controlling discovery. Members of 
the same soft zone automatically discover and communicate freely with all other 
members of the same zone. The soft zone boundary is not secure; traffic across 
soft zones can occur if addressed correctly. Soft zones that include members from 
multiple switches need not include the ports of the inter-switch links. Soft zone 
boundaries yield to ACL and VPF zone boundaries. Soft zones can overlap; that 
is, a port can be a member of more than one soft zone. Membership can be 
defined by Fibre Channel address, port ID and domain ID, or worldwide name. 
Soft zoning supports all port modes.

Note: Domain ID conflicts can result in automatic reassignment of switch 
domain IDs. These reassignments are not reflected in zones that use 
domain ID and port number pairs or Fibre Channel addresses to define 
their membership. Be sure to reconfigure zones that are affected by a 
domain ID change. To prevent zoning definitions from becoming invalid 
when the membership is defined by domain ID/port number or Fibre 
Channel address, use the Set Config Switch command to lock domain 
IDs. Refer to the ”Set Config Command” on page A-24.
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3.4.1.1.2

Access Control List Hard Zones
Access Control List (ACL) zoning divides the fabric for purposes of controlling 
discovery and inbound traffic. ACL zoning is a type of hard zoning that is 
hardware enforced. This type of zoning is useful for controlling access to certain 
devices without totally isolating them from the fabric. Members can communicate 
with each other and transmit outside the ACL zone, but cannot receive inbound 
traffic from outside the zone. The ACL zone boundary is secure against inbound 
traffic. ACL zones can overlap; that is, a port can be a member of more than one 
ACL zone. ACL zones that include members from multiple switches need not 
include the ports of the inter-switch links. ACL zone boundaries supersede soft 
zone boundaries, but yield to VPF zone boundaries. Membership can be defined 
only by port ID and domain ID. ACL zoning supports all port modes except 
TL_Ports.

3.4.1.1.3

Virtual Private Fabric Hard Zones
Virtual Private Fabric (VPF) zoning divides the fabric for purposes of controlling 
discovery and both inbound and outbound traffic. This type of zoning is useful for 
providing security and reserving paths between devices to guarantee bandwidth. 
VPF zoning is a type of hard zoning that is hardware enforced. Members can only 
transmit to and receive from members of the same VPF zone. The VPF zone 
boundary is secure against both inbound and outbound traffic. VPF zones that 
include members from multiple switches must include the ports of the inter-switch 
links. VPF zones cannot overlap; that is, a port can be a member of only one VPF 
zone. VPF zone boundaries supersede both soft and ACL zone boundaries. 
Membership can be defined only by port ID and domain ID. VPF zoning supports 
all port modes.

3.4.1.2

Aliases
To make it easier to add a group of ports or devices to one or more zones, you can 
create an alias. An alias is a named set of ports or devices that are grouped 
together for convenience. Unlike zones, aliases impose no communication 
restrictions between its members. You can add an alias to one or more zones. 
However, you cannot add a zone to an alias, nor can an alias be a member of 
another alias.
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3.4.1.3

Zone Sets
A zone set is a named group of zones. A zone can be a member of more than one 
zone set. All zones that are not members of a zone set belong to the orphan zone 
set. The orphan zone set is saved to the switch. Each switch in the fabric 
maintains its own zoning database containing one or more zone sets. This zoning 
database resides in non-volatile or permanent memory and is therefore retained 
after a reset. Refer to ”Configured Zonesets Data Window” on page 4-6 for 
information about displaying the zoning database.

To apply zoning to a fabric, choose a zone set and activate it. When you activate a 
zone set, the switch distributes that zone set to every switch in the fabric. 
Therefore, every switch in the fabric will have identical active zone sets. Refer to 
”Active Zone Set Data Window” on page 3-8 for information about displaying the 
active zone set.

3.4.1.4

Zoning Database
Each switch has its own zoning database. The zoning database is made up of all 
aliases, zones, and zone sets that have been created on the switch or received 
from other switches. The switch maintains two copies of the zoning database: one 
copy is maintained in temporary memory for editing purposes; the second copy is 
maintained in permanent memory. When you modify aliases, zones, and zone 
sets, these changes are made to the temporary zoning database. If you reset the 
switch or lose power to the switch before saving the permanent zoning database, 
the changes will be lost.

The Auto Save zoning configuration parameter controls whether the temporary 
zoning database is automatically saved in permanent memory. Refer to ”Zoning 
Configuration” on page 3-13 for more information about the Auto Save 
parameters.
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3.4.1.5

Zoning Configuration
Note the following SANbox2 zoning configuration concepts:

■ Orphan zones are allowed.

■ You can not edit an active zone set.

■ The three types of zones are Soft, VPF, and ACL.

■ Aliases are allowed.

■ The zoning limits for a fabric are:

■ Maximum number of zonesets is 256

■ Maximum number of zones is 256

■ Maximum number of aliases is 256

■ Maximum number of members per zone is 2000

■ Maximum number of members per aliases is 2000

■ Maximum total number of members is 2000

■ The entire zoning database can be saved to either temporary or permanent 
memory.

You can set the zoning configuration parameters using SANbox Manager or the 
Set Zoning Config command. Refer to ”Using the Zoning Config Window” on 
page 3-15 for information about zoning configuration using SANbox Manager. 
Refer to ”Set Config Command” on page A-24 for information about the Set 
Config command.

The following parameters make up the zoning configuration:

■ Auto Save

■ Merge Mode

■ Default Visibility
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3.4.1.5.1

Auto Save
The Auto Save parameter on a switch determines whether zoning changes 
received from other switches in the fabric will be automatically saved to 
permanent memory on that switch. Zoning changes you apply to your switch are 
automatically saved to permanent memory on your switch, but where those 
changes are saved on each switch in the fabric is dependent on whether a switch 
has the Auto Save parameter enabled or disabled.

Zoning changes are saved to temporary memory on all switches in the fabric. If 
Auto Save is enabled, the switch firmware automatically saves the zoning 
changes it receives to both temporary and permanent memory on that switch. If 
Auto Save is disabled on a switch, any zoning changes that the switch receives 
will be stored only in its temporary memory.

How the save operation is triggered depends on the selected merge mode. When 
in SW-2 merge mode, changes are saved when an updated zone set is activated. 
When in Brocade™ merge mode, changes are saved when any zone set is 
updated. You can save the zoning database to permanent memory (if Auto Save 
is disabled) using the Zoning command. Refer to Zoning Command on page A-67.

3.4.1.5.2

Merge Mode
The Merge Mode parameter enables a SANbox2 switch to interoperate with 
Brocade switches running non-FC-SW-2-compliant firmware. There are two 
merge modes: SW2 and Brocade Proprietary. The SW2 merge mode is intended 
for FC-SW-2 compliant switches. The Brocade merge mode is intended for 
SANbox2 fabrics that include Brocade switches with non-FC-SW-2 compliant 
firmware. All switches in a fabric should be set to the same merge mode, 
otherwise the switches may become isolated from each other.

When you activate a zone set, the SW2 merge mode causes the active zone set 
to be distributed to temporary memory on all switches in the fabric. This ensures 
that all switches have identical active zone sets. The Brocade merge mode 
propagates the entire zoning database to temporary memory on all switches in the 
fabric anytime the zoning database is changed and saved on any switch.

3.4.1.5.3

Default Visibility
Default Visibility determines the level of communication that is permitted between 
devices when there is no active zone set. The default visibility parameter can be 
set differently on each switch. When default visibility is enabled (All) on a switch, 
the switch and its devices can communicate with all devices in the fabric. When 
Default Visibility is disabled (None) on a switch, none of the ports on that switch 
can communicate with any other port in the fabric.
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3.4.2

Using the Zoning Config Window
Use the Zoning Config window to change the Auto Save, Merge Mode, and 
Default Visibility configuration parameters. In the faceplate display, open the 
Zoning menu and select Edit Zoning Config to open the Zoning Config window 
shown in Figure 3-3. After making changes, choose the OK button to put the new 
values into effect.

Figure 3-3.  Zoning Config Window

3.4.3

Restoring Default Zoning
Restoring the default zoning clears the switch of all zoning definitions.

To restore the default zoning for a switch: 

1. In the faceplate display, open the Zoning menu and select Restore Default 
Zoning.

2. Choose the OK button to confirm that you want to restore default zoning and 
save changes to the zoning database.

CAUTION! The use of this command will deactivate any active zone set. If 
the switch is not isolated from the fabric, this command will 
deactivate the active zone set for the entire fabric.
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3.4.4

Merging Fabrics and Zoning
If you join two fabrics, the active zone sets from the two fabrics attempt to merge. 
The fabrics may consist of a single switch or many switches already connected 
together. The switches in the two fabrics attempt to create a new active zone set 
containing the union of each fabric’s active zone set. The propagation of zoning 
information only affects the active zone set, not the configured zone sets, unless 
the Merge Mode is set to "Brocade Proprietary". Refer to ”Merge Mode” on 
page 3-14.

3.4.4.1

Zone Merge Failure
If a zone merge is unsuccessful, the inter-switch links between the fabrics will 
isolate due to a zone merge failure, which will generate an alarm log entry. The 
reason for the E_Port isolation can also be determined by viewing the port 
information. Refer to ”Port Information Data Window” on page 4-5 and the ”Show 
Command” on page A-39 (Port keyword).

A zone merge will fail under the following conditions:

■ The Merge Mode in the two fabrics is different. All switches in the combined 
fabric must have the same merge mode.

■ The two active zone sets have member zones with identical names that 
differ in content or type. For example, consider Fabric A and Fabric B each 
with a zone in its active zone set named “ZS1”. Fabric A "ZS1" contains a 
member specified by  Domain ID 1 and Port 1; Fabric B “ZS1” contains a 
member specified by Domain ID 1 and Port 2. In this case, the merge will fail 
and the inter-switch links between the fabrics will isolate.

3.4.4.2

Zone Merge Failure Recovery
When a zone merge failure occurs, the conflict that caused the failure must be 
resolved. If the failure was due to differing Merge Modes, change the Merge Mode 
on the switches in one of the fabrics to match the other fabric. Refer to ”Using the 
Zoning Config Window” on page 3-15 for information about changing the Merge 
Mode. To permit the fabrics to join, reset the ports that were isolated. Refer to 
”Resetting a Port” on page 5-13.

1. You can correct a failure due to a zone conflict by deactivating one of the 
active zone sets or editing the conflicting zones so that their membership is 
the same. You can deactivate the active zone set on one switch if the active 
zone set on the other switch accurately defines your zoning needs. If not, 
you must edit the zone memberships, and reactivate the zone sets. Refer to 
”Managing Zones” on page 3-22 for information about adding and removing 
zone members. To permit the fabrics to join, reset the ports that were 
isolated. Refer to ”Resetting a Port” on page 5-13.
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3.4.5

Using the Edit Zoning Window
To edit the zoning database for a particular switch, open the Zoning menu from 
the faceplate display and select Edit Zoning to open the Edit Zoning window 
shown in Figure 3-4. Changes can only be made to an inactive zone set, which 
will be stored in flash (non-volatile) memory and retained after resetting a switch.

The Edit Zoning window has a Zone Sets tree on the left and a Port/Device (or 
members) tree on the right. Both trees use display conventions similar to the 
fabric tree for expanding and contracting zone sets, zones, and ports. An 
expanded port shows the port Fibre Channel address; an expanded address 
shows the port worldwide name. You can select zone sets, zones, and ports in the 
following ways:

■ Click a zone, zone set, or port icon.

■ Right-click to select a zone set or zone, and open the corresponding popup 
menu.

■ Hold down the Shift key while clicking several consecutive icons.

■ Hold down the Control key while clicking several non-consecutive icons. 

Figure 3-4.  Edit Zoning Window

Port/Device 
Tree

Zone Sets 
Tree
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Using tool bar buttons, popup menus, or a drag-and-drop method, you can create 
and manage zone sets and zones in the zoning database. The Apply button 
saves changes to the zoning database without closing the window. The OK button 
saves the zoning changes to the database and closes the window. The tool bar 
presents the following operations:

Table 3-2. Edit Zoning Window Tool Bar Buttons

Tool Bar Button Description

Create Zone Set button - create a new zone set

Create Zone button - create a new zone

Create Alias button - create another name for a set of objects

Add Member button - add the selected zone to a zone set, or 
add the selected port to a zone

Remove Member button - delete the selected zone from a zone 
set, or delete the selected port from a zone
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3.4.6

Managing Zone Sets
Zoning a fabric involves creating a zone set, creating zones as zone set members, 
then adding devices as zone members. The zoning database supports multiple 
zone sets to serve the different security and access needs of your storage area 
network, but only one zone set can be active at one time. Managing zone sets 
consists of the following tasks:

■ Creating zone sets

■ Activating and deactivating zone sets

■ Copying a zone to a zone set

■ Removing a zone from one zone set or from all zone sets

■ Removing a zone set

■ Removing all zoning definitions

Note: Changes that you make to the zoning database behave as follows:

■ In SW2 merge mode, changes to configured zone sets are limited 
to the managed switch and do not propagate to the rest of the 
fabric. To distribute changes to configured zone sets fabric wide, 
you must edit the zoning databases on the individual switches.

■ In Brocade merge mode, when a zone set is activated, the entire 
zoning database, including any changes, is distributed from the 
managed switch throughout the fabric.
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3.4.6.1

Creating a Zone Set
To create a zone set, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. Open the Edit menu, and select Create Zone Set to open the Create Zone 
Set window.

3. Enter a name for the zone set, and choose the OK button. The new zone set 
name is displayed in the Zone Sets window.

4. To create new zones in a zone set, do one of the following:

■ Right-click a zone set and select Create A Zone from the popup menu. 
In the Create a Zone window, enter a name for the new zone, and 
choose the OK button. The new zone name is displayed in the Zone 
Sets window.

■ Copy an existing zone by dragging a zone into the new zone set. Refer 
to ”Copying a Zone to a Zone Set” on page 3-21.

5. Choose the Apply button to save changes to the zoning database.

3.4.6.2

Activating and Deactivating a Zone Set
You must activate a zone set to apply its zoning definitions to the fabric. Only one 
zone set can be active at one time. When you activate a zone set, the switch 
distributes that zone set to the temporary zoning database on every switch in the 
fabric replacing any zone set of the same name. If Auto Save is enabled, the zone 
set is saved in the permanent zoning database also. Refer to ”Auto Save” on 
page 3-14.

The purpose of the deactivate function is to suspend all fabric zoning which 
results in free communication fabric wide or no communication depending on the 
default visibility setting. Refer to ”Default Visibility” on page 3-14 for more 
information. It is not necessary to deactivate the active zone set before activating 
a new one.

■ To activate a zone set, open the Zoning menu and select Activate Zone Set 
to open the Activate Zone Set window. Select a zone set from the Select 
Zone Set pull-down menu, and choose the Activate button.

■ To deactivate the active zone set, open the Zoning menu, select Deactivate 
Zone Set. Acknowledge the warning about traffic disruption, and choose the 
Yes button to confirm that you want to deactivate the active zone set.
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3.4.6.3

Copying a Zone to a Zone Set
To copy an existing zone and its membership from one zone set to another, select 
the zone and drag it to the chosen zone set. Choose the Apply button to save 
changes to the zoning database.

3.4.6.4

Removing a Zone from a Zone Set or from All Zone Sets
You can remove a zone from a zone set or from all zone sets in the database.

1. In the Faceplate Display, open the Zoning menu and select Edit Zoning to 
open the Edit Zoning window. 

2. In the Zone Sets tree, select the zone(s) to be removed. 

3. Open the Edit menu, and select Remove to remove the zone from the zone 
set, or select Remove from All Zones to remove the zone from all zone 
sets.

4. Choose the Apply button to save changes to the zoning database.

Alternatively, you may use shortcut menus to remove a zone from a zone set or 
from all zone sets in the database.

3.4.6.5

Removing a Zone Set
Removing a zone set from the database affects the member zones in the following 
ways. 

■ Member zones that are members of other zone sets are not affected.

■ Member zones that are not members of other zone sets become members 
of the orphan zone set.

To delete a zone set from the database, do the following: 

1. In the faceplate display, open the Zoning menu and select Edit Zoning to 
open the Edit Zoning window. 

2. In the Zone Sets tree, select the zone set to be removed. 

3. Open the Edit menu, and select Remove to remove the zone set.

4. Choose the Apply button to save changes to the zoning database.

Alternatively, you may use shortcut menus to remove a zone set from the 
database. 
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3.4.6.6

Removing All Zoning Definitions
To clear all zone and zone set definitions from the zoning database, choose one of 
the following:

■ Open the Edit menu and select Remove All. In the Remove All window, 
choose the Yes button to confirm that you want to delete all zones and zone 
sets. 

■ Right-click the Zone Sets heading at the top of the Zone Sets tree, and 
select Clear Zoning from the popup menu. Choose the Yes button to 
confirm that you want to delete all zone sets and zones. 

3.4.7

Managing Zones
Managing zones involves the following:

■ Creating a zone in a zone set

■ Adding zone members

■ Renaming a zone or a zone set

■ Removing a zone member

■ Removing a zone from a zone set

■ Removing a zone from all zone sets

■ Changing zone types

3.4.7.1

Creating a Zone in a Zone Set
When a zone is created, it’s zone type is soft. To change the zone type to a hard 
zone (ACL or VPF), refer to ”Changing Zone Types” on page 3-25 for more 
information. Refer to ”Zones” on page 3-10 for information on zone types (soft and 
hard). To create a zone in a zone set, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window. 

Note: Changes that you make to the zoning database behave as follows:

■ In SW2 merge mode, changes to configured zone sets are limited 
to the managed switch and do not propagate to the rest of the 
fabric. To distribute changes to configured zone sets fabric wide, 
you must edit the zoning databases on the individual switches.

■ In Brocade merge mode, when a zone set is activated, the entire 
zoning database, including any changes, is distributed from the 
managed switch throughout the fabric.
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2. Open the Edit menu and select Create a Zone. 

3. In the Create a Zone window, enter a name for the new zone, and choose 
the OK button. The new zone name is displayed in the Zone Sets window.

4. To add ports or devices to the zone, do one of the following:

■ In the zone set tree, select the zone set. In the graphic window, select 
the port to add to the zone. Open the Edit menu and select Add 
Members. 

■ Select a port by port number, Fibre Channel address, or worldwide 
name in the Port/Device tree, and drag it into the zone.

■ Select a port by port number, Fibre Channel address, or worldwide 
name in the Port/Device tree. Right-click the zone and select Add 
Zone Members from the popup menu.

5. Choose the Apply button to save changes to the zoning database.

3.4.7.2

Adding Zone Members
Adding a zone member to a zone will affect every zone set in which that zone is a 
member. To add member ports/devices to a zone, do one of the following:

■ Select a port by port number, Fibre Channel address, or worldwide name in 
the Port/Device tree, and drag it into the zone. To select and drag multiple 
ports/devices, press and hold the Control key while dragging.

■ Select one or more ports by port number, Fibre Channel address, or 
worldwide name in the Port/Device tree. Right-click the zone and select Add 
Zone Members from the popup menu.

Choose the Apply button to save changes to the zoning database.

Note: If you enter the name of a zone that already exists in the 
database, the SANbox Manager application will create a copy of 
that zone and its membership in the zone set.

Note: Domain ID conflicts can result in automatic reassignment of switch 
domain IDs. These reassignments are not reflected in zones that use 
domain ID/port number pair to define their membership. Be sure to 
reconfigure zones that are affected by a domain ID change.
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3.4.7.3

Renaming a Zone or a Zone Set
To rename a zone, do the following:

1. In the Zone Sets tree of the Edit Zoning window, click the zone/zone set to 
be renamed.

2. Open the Edit menu and select Rename.

3. In the Rename Zone/Rename Zone Set window, enter a new name for the 
zone/zone set.

4. Choose the OK button.

3.4.7.4

Removing a Zone Member 
Removing a zone member will affect every zone and zone set in which that zone 
is a member. To remove a member from a zone:

1. In the Edit Zoning window, select the zone member to be removed.

2. Open the Edit menu and select Remove.

3. Choose the OK button to save the changes and close the Edit Zoning 
window.

3.4.7.5

Removing a Zone from a Zone Set
Removing a zone from a zone set will affect every zone set in which that zone is a 
member. To delete a zone from a zone set:

1. In the Edit Zoning window, select the zone to be removed.

2. Open the Edit menu and select Remove.

3. Choose the OK button to save the changes and close the Edit Zoning 
window.

3.4.7.6

Removing a Zone from All Zone Sets
To delete a zone from all zone sets, do the following:

1. In the Edit Zoning window, select the zone to be removed.

2. Open the Edit menu and select Remove Zone from All Sets.

3. Choose the OK button to save the changes and close the Edit Zoning 
window.
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3.4.7.7

Changing Zone Types
To change a zone type, do the following:

1. In the faceplate display, select the switch with the zone type to change.

2. Choose the Zoning button to open the Edit Zoning window.

3. In the Zone Sets tree, select the zone to change.

4. Open the Edit menu and select Set Zone Type to open the Set Zone Type 
window.

5. Open the Zone Type pull-down menu and select Soft, VPF (virtual private 
fabric), or ACL (access control list). Refer to ”Soft Zones” on page 3-10, 
”Access Control List Hard Zones” on page 3-11, or ”Virtual Private Fabric 
Hard Zones” on page 3-11 for a description of these zone types.

3.4.8

Managing Aliases
An alias is a collection of objects that can be zoned together. An alias is not a 
zone, and can not have a zone or another alias as a member.

3.4.8.1

Creating an Alias
To create an alias, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. Open the Edit menu, and select Create Alias to open the Create Alias 
window.

3. Enter a name for the alias, and choose the OK button. The alias name is 
displayed in the Zone Sets window.

4. Choose the OK button to save the alias name to the zoning database.

Note: Changes that you make to the zoning database behave as follows:

■ In SW2 merge mode, changes to configured zone sets are limited 
to the managed switch and do not propagate to the rest of the 
fabric. To distribute changes to configured zone sets fabric wide, 
you must edit the zoning databases on the individual switches.

■ In Brocade merge mode, when a zone set is activated, the entire 
zoning database, including any changes, is distributed from the 
managed switch throughout the fabric.
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3.4.8.2

Adding a Member to an Alias
The three ways to add a member to an alias are:

■ Drag-and-drop method.

■ Select the alias in the left pane and the member in the right pane to add to 
that alias, and choose the Insert button.

■ Select the alias in the left pane and the member in the right pane to add to 
that alias, and open the Edit menu and select Add Members.

To add a member to an alias using the drag-and-drop method, do the following:

1. In the right pane, click and hold down the mouse button on the member to 
be added to the alias.

2. Drag the selected member from the right pane to the alias in the left pane.

To add a member to an alias using the menu options, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. In the left pane, select an alias.

3. In the right pane, select the member to add to the selected alias.

4. Choose one of the following: 

■ Open the Edit menu and select Add Members.

■ Choose the Insert button.

5. Choose the OK button to save the changes and close the Edit Zoning 
window.

3.4.8.3

Removing an Alias from All Zones
To remove an alias from all zones, do the following:

1. In the Zone Sets tree in the Edit Zoning window, select the alias to be 
removed.

2. Open the Edit menu, and select Remove Alias from All Zones.

3. Choose the Yes button in the Remove window.
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Section 4
Managing Switches

This section describes the following tasks that manage switches in the fabric.

■ Displaying switch information

■ Exporting alarm log information to a file

■ Exporting name server information to a file

■ Paging a switch

■ Resetting a switch

■ Configuring a switch

■ Archiving a switch

■ Restoring a switch

■ Loading firmware

■ Restoring the factory default configuration

4.1

Displaying Switch Information
The faceplate display and data windows provide the following specific switch 
information:

■ Hardware status

■ Name server information

■ Switch specifications and addresses

■ Configuration parameters

■ Performance statistics

■ Configured zone sets

■ Alarm log information
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Figure 4-1.  Faceplate Display

The fabric updates the topology and faceplate displays by forwarding changes in 
status to the management workstation as they occur. You can allow the fabric to 
update the switch status, or you can refresh the display at any time. To refresh 
switch status in the display, do one of the following:

■ Choose the Refresh button.

■ Open the View menu and select Refresh.

■ Press the F5 key.

■ Right-click a switch in the topology display and select Refresh Switch from 
the popup menu.

■ Right-click in the graphic window of the faceplate display, and select 
Refresh Switch from the popup menu.

4.1.1

Displaying Hardware Status
A SANbox2 switch is equipped with the following chassis LEDs that provide 
hardware status information:

■ Chassis Over Temperature LED - indicates air temperature inside the 
switch.

■ Fan Fail LED - indicates operational status of both fans. 

■ Heartbeat LED - indicates the status of the internal switch processor and the 
results of Power On Self Tests (POSTs).

■ Input Power LED - indicates the voltage status at the switch logic circuitry.
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You can display a summary of this status information by placing the cursor on the 
chassis LED cluster as shown in Figure 4-2. Refer to SANbox2 Fibre Channel 
Switch Installer’s/User’s Manual for more information about the chassis LEDs.

Figure 4-2.  Faceplate Display - Chassis LED Cluster

4.1.2

Name Server Data Window
The Name Server data window displays information about the devices logged into 
the fabric. It is available in both the topology display and the faceplate display. 
Choose the Name Server tab below the data window to display name server data 
for the selected fabric. To narrow the display, select on or more switches. Refer to 
”Name Server Data Window Entries” on page 4-3 for a  description of the fields in 
the Name Server data window. Refer to ”Exporting Name Server Information to a 
File” on page 4-7 to export name server information to a file.

Table 4-1. Name Server Data Window Entries

Entry Description

Device Device number in the fabric

Switch Switch name

Port Port number (0 - 15)

Address Fibre Channel address

Type Node type

WWNN Worldwide node name

WWPN Worldwide port name

Vendor Host Bus Adapter/Device Vendor

FC-4 Types Device Fibre Channel protocol types
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4.1.3

Switch Data Window
The Switch data window displays current network and switch information for the 
selected switches. Refer to ”Configuring a Switch” on page 4-7 for more 
information about the Switch data window. To open the Switch data window, select 
one or more switches in the topology display and choose the Switch tab below 
the window. You can also open the Switch data window in the faceplate display. 
Table 4-2 describes the Switch data window entries.

Table 4-2. Switch Data Window Entries 

Entry Description

FcAddress Switch Fibre Channel address

World Wide Name Switch worldwide name

Reason for Status Additional status information

User Name Name of user

Login Level Security level

Vendor Switch manufacturer

Flash Version Active Flash

Inactive Flash Version Inactive firmware version

PROM/Flasher Version Firmware version

MAC Address Media Access Control address

IP Address Internet Protocol Address

Negotiated Domain ID The domain ID currently being used by the fabric

Configured Domain ID The domain ID defined by network administrator

Number of Ports Number of ports on the switch

Switch Type Switch model

Operational State Switch operational state: Online, Offline, Diagnostic

Administrative State Switch administrative state: Online, Offline, 
Diagnostic

MFS Timeout Multi frame sequencing timeout value

RA Timeout Resource allocation timeout value

RT Timeout Receiver transmitter timeout value
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4.1.4

Port Statistics Data Window
The Port Statistics data window displays port performance data for the selected 
ports. To open the Port Statistics data window, choose the Port Stats tab below 
the data window in the faceplate display. Refer to Table 5-5 for a description of the 
Port Statistics data window entries.

The Statistics pull-down menu is available on the Port Statistics data window, and 
provides different ways to view detailed port information. Choose the down arrow 
to open the pull-down menu. Open the pull-down menu and select Absolute to 
view the total count of statistics since the last switch reset. Select Rate to view the 
number of statistics counted per second over the polling period. Select Baseline 
to view the total count of statistics since the last time the baseline was set. 
Choose the Clear Baseline button to set the current baseline.

4.1.5

Port Information Data Window
The Port Information data window displays port detail information for the selected 
ports. To open the Port Statistics data window, choose the Port Info tab below the 
data window in the faceplate display. Refer to Table 5-6 for a description of the 
Port Information data window entries.

ED Timeout Error detect timeout value

Zoning Merge Mode SW2 Standard or Brocade Proprietary

Zoning Merge Auto Save Whether zoning auto save is on (default) or off

Zoning Default Visibility Whether zoning visibility is set to All (default) or None

Temperature Internal switch temperature °C

Fan 1 Status Fan status

Fan 2 Status Fan status

Fan 3 Status Fan status

Power Supply 1 Status Power supply 1 status

Power Supply 2 Status Power supply 2 status

Beacon Status Whether LEDs on the switch are blinking (on or off).

Broadcast Support Whether broadcast support is enabled or disabled 
(default).

Table 4-2. Switch Data Window Entries (Continued)

Entry Description
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4.1.6

Configured Zonesets Data Window
The Configured Zonesets data window displays all zone sets, zones, and zone 
membership in the zoning database, as shown in Figure 4-3. To open the 
Configured Zonesets data window, choose the Configured Zonesets tab below 
the data window in the faceplate display.

The Configured Zonesets data window uses display conventions for expanding 
and contracting entries that are similar to the fabric tree. An entry handle located 
to the left of an entry in the tree indicates that the entry can be expanded. Click 
this handle or double-click the following entries to expand or contract them:

■ A zone set entry expands to show its member zones.

■ A zone entry expands to show its members by port number, worldwide 
name, or Fibre Channel address.

Figure 4-3.  Configured Zonesets Data Window

4.1.7

Alarm Log Data Window
The Alarm Log data window displays switch event information. To open the Alarm 
Log data window, choose the Alarm Log tab below the data window in the 
faceplate display. 
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4.2

Exporting Alarm Log Information to a File
To save switch alarm log information to file, open the faceplate display and do the 
following:

1. Open the Switch menu and select Export Alarm Log. 

2. In the Save window, enter a file name.

3. Choose the Save button.

4.3

Exporting Name Server Information to a File
To save switch name server information to file, open the topology display and do 
the following:

1. Open the Switch menu and select Export Name Server. 

2. In the Save window, enter a file name.

3. Choose the Save button.

4.4

Paging a Switch
You can use the beacon feature to page a switch. The beacon feature causes all 
port Logged-In LEDs to flash, making it easier to recognize. To page a switch, 
open the Switch menu in the faceplate display and enable the Toggle Beacon 
selection. To cancel the beacon, reselect Toggle Beacon.

4.5

Resetting a Switch
Resetting a switch reboots the switch using configuration parameters in memory. 
You can reset a switch in the following ways:

■ Select the switch to be reset in the fabric tree. Open the Switch menu and 
select Reset Switch.

■ Turn both power supplies off, then turn one or both of them back on.

4.6

Configuring a Switch
Switch configuration is divided into two areas: chassis configuration and network 
configuration. Chassis configuration specifies switch-wide Fibre Channel settings. 
Network configuration specifies Ethernet and SNMP related settings.

To open the Switch Properties window, open the Switch menu and select Switch 
Properties. You may also right-click a switch graphic in the topology display or 
faceplate display, and select Switch Properties from the popup menu.
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4.6.1

Switch Configuration
Use the Switch Properties window to change the chassis name, administrative 
state, domain ID, and to enable or disable broadcast support. Broadcast support 
provides support for IP broadcast over Fibre Channel. The timeout values are 
displayed for reference purposes only when the switch is online. These fields 
become activate when the switch is take offline and then redisplaying the Switch 
Properties window. After making changes, choose the OK button to put the new 
values into effect.

Figure 4-4.  Switch Properties Window

4.6.1.1

Chassis Name
A user-defined name that identifies the switch. The default is SANbox2.

4.6.1.2

Switch Administrative States
The switch administrative state specifies the operational status of the switch. 
Table 4-3 describes the administrative state values. When applied to the switch, 
the administrative state becomes the operational state.

Table 4-3. Switch Administrative States

Parameter Description

Online The switch is available.

Offline The switch is unavailable.

Test The switch is in test mode and is unavailable.



4 – Managing Switches
Configuring a Switch

59022-03 D 4-9

�

4.6.1.3

Domain ID
The domain ID is a unique Fibre Channel identifier for the switch. The Fibre 
Channel address consists of the domain ID, port ID, and the Arbitrated Loop 
Physical Address (ALPA). The maximum number of switches within a fabric is 239 
with each switch having a unique domain ID.

Switches come from the factory with the domain IDs unlocked (DomainID-Lock= 
FALSE). This means that if there is a domain ID conflict in the fabric, the switch 
with the highest principal priority, or the principal switch, will reassign any domain 
ID conflicts and establish the fabric. If you lock the domain ID on a switch 
(DomainIDLock=TRUE) and a domain ID conflict occurs, the switch with the 
higher WWN will isolate as a separate fabric and the Logged-In LEDs on both 
switches will flash to show the affected ports. Refer to the ”Set Config Command” 
on page A-24 for information about the Switch keyword and the DomainIDLock 
and PrincipalPriority parameters.

If you connect a new switch to an existing fabric with its domain ID unlocked, and 
a domain conflict occurs, the new switch will isolate as a separate fabric. 
However, you can remedy this by resetting the new switch or taking it offline then 
back online. The principal switch will reassign the domain ID and the switch will 
join the fabric.

4.6.1.4

Broadcast Support
Broadcast is supported on the SANbox2 which allows for IP-over-Fibre Channel 
support support. Broadcast is implemented using the proposed standard specified 
in Multi-Switch Broadcast for FC-SW-3, T11 Presentation Number T11/02-031v0. 
FSPF is used to setup a fabric spanning tree used in transmission of broadcast 
frames. Broadcast frames are retransmitted on all ISLs indicated in the spanning 
tree and all online F/FL ports. Broadcast zoning is supported with Access Control 
List (ACL) and Virtual Private Fabric (VPF) hard zones. When a broadcast frame 
is received, these hard zones are enforced at the F/FL port. If the originator of the 
broadcast is in a hard zone, the frame is retransmitted on all online F/FL ports 
within the hard zone. If the originator of the broadcast frame is not in a hard zone, 
the frame is retransmitted on online F/FL ports that are not in a hard zone.

Note: Domain ID reassignment is not reflected in zoning that is defined by 
domain ID and port number pair. You must reconfigure zones that are 
affected by domain ID reassignment.
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4.6.1.5

Timeout Values
The switch timeout values determine the timeout values for all ports on the switch. 
Table 4-4 describes the switch timeout parameters. The R_A_TOV, R_T_TOV, or 
E_D_TOV values must be the same for all switches in the fabric. 

Note: Timeout values can only be changed if the switch operational state is 
offline.

Table 4-4. Timeout Values

Parameter Description

R_A_TOV Resource Allocation Timeout. The maximum amount of time a 
frame could be delayed in the fabric and still be delivered. The 
default is 10000 milliseconds.

R_T_TOV Receiver Transmitter Timeout. The amount of time that 
synchonization may be lost between two ports before link 
failure is detected. The default is 100 milliseconds.

E_D_TOV Error Detect Timeout. The maximum round trip time that an 
operation between two N_Ports could require. The default is 
2000 milliseconds.
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4.6.2

Network Configuration
Use the Network Properties window shown in Figure 4-5 to change IP and SNMP 
configuration parameters. After making changes, choose the OK button to put the 
new values into effect. To open the Network Properties window, open the Switch 
menu and select Network Properties.

Figure 4-5.  Network Properties Window

Note: Since Read Community, Trap Community, and Write Community 
settings are like passwords, they are write-only fields; the current 
settings are not displayed. 
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4.6.2.1

IP Configuration
The IP configuration identifies the switch on the Ethernet network and determines 
which boot method to use. Table 4-5 describes the IP configuration parameters.

Table 4-5. IP Configuration Parameters

 Parameter Description

IP Address Internet Protocol (IP) address for the Ethernet port. The default and 
PROM mode value is 10.0.0.1.

Subnet mask Subnet mask address for the Ethernet port. The default and PROM 
mode value is 255.0.0.0.

Boot Method Choose one of the following methods:
■ Static - Uses the IP configuration parameters entered in the 

Switch Properties window.
■ BootP - Acquires the IP configuration from a BootP server.
■ RARP (Reverse Address Resolution Protocol) - Acquires the IP 

address from an RARP server. A RARP request is broadcast, 
with up to three retries, each at 5 second intervals. If no IP 
address is obtained, the switch reverts to the previously 
configured IP address.

■ DHCP (Dynamic Host Configuration Protocol) - Acquires the IP 
configuration from a DHCP server. If no satisfactory lease is 
obtained, the DHCP client attempts to use the previously 
configured lease. If the previous lease cannot be used, no IP 
address will be assigned to this switch in order to avoid an IP 
address conflict. The DHCP server must then be made available.

If a BootP, RARP, or DHCP server is not available, the switch will 
boot. However, you will be unable to manage the switch through the 
Ethernet connection. To manage a switch under these 
circumstances, the connection must be made through the serial port 
or inband from another switch.

Gateway IP gateway address. The default and PROM mode value is 
10.0.0.254.
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4.6.2.2

Remote Logging
The Remote Logging (syslog) feature enables saving of the log information to a 
remote host that supports the syslog protocol. When enabled, the log entries are 
sent to the syslog host at the IP address that you specify in the Logging Host IP 
Address field. Log entries are saved in the internal switch log whether this feature 
is enabled or not.

To save log information to a remote host, you must edit the syslog.conf file and 
then restart the syslog daemon. The syslog.conf file on the remote host must 
contain an entry that specifies the name of the log file in which to save error 
messages. Add the following line to the syslog.conf file. A <tab> separates the 
selector field (local0.info) and action field which contains the log file path name 
(/var/adm/messages/messages.name).

local0.info <tab> /var/adm/messages.name

4.6.2.3

SNMP Configuration
The SNMP configuration defines how authentication traps are managed. 
Table 4-6 describes the SNMP configuration parameters.

Table 4-6. SNMP Configuration Parameters

 Parameter Description

Contact Specifies the name of the contact person who is to be contacted to 
respond to trap events. The default is undefined.

Read 
Community

Read Community Authentication. A write-only field; the value on the 
switch and the SNMP management server must be the same. The 
default value is Public.

Trap Community Trap Community Authentication. A write-only field; the value on the 
switch and the SNMP management server must be the same. The 
default value is Public.

Location Specifies the switch location. The default is undefined.

Authentication 
Trap

Enables or disables the reporting of SNMP authentication failures. If 
enabled, a notification trap is sent to the configured trap addresses in 
the event of an authentication failure if incorrect community string 
values are used. The default value is False.

Write 
Community

Write Community Authentication. A write-only field; the value on the 
switch and the SNMP management server must be the same. The 
default value is Private.
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4.6.2.4

SNMP Trap Configuration
The SNMP trap configuration defines how traps are sent. Table 4-7 describes the 
SNMP configuration parameters.

4.6.3

Configuration Backup
Changes made to the switch since it was manufactured can be saved to a file in 
non-volatile memory. However the backup is lost if the switch is reset. Use the 
FTP User Images procedures to save the configdata file to the workstation. (In 
FTP, no directory listing is available. The configuration backup file is always 
named configdata.) Refer to the ”Config Command” on page A-7 for more 
information. Refer to ”Archiving a Switch” on page 4-15.

4.6.4

Configuration Restore
Switch configurations can be “cloned” to easily propagate an identical 
configuration to other switches. Use the FTP User Images procedures with the 
Put command to send the previously saved (using config backup) configdata file 
to the switch. Use the Config Restore command to return the switch configuration 
to the previously saved configuration. The switch is automatically reset upon a 
successful restore. Refer to the ”Config Command” on page A-7 for more 
information. Refer to ”Restoring a Switch” on page 4-16.

Table 4-7. SNMP Trap Configuration Parameters 

 Parameter Description

Trap Enabled Check box to enable or disable the trap.

Trap Address Specifies the IP address to which SNMP traps are sent. The default 
is 127.0.0.1. A maximum of 5 trap addresses are supported.

Trap Port The port number on which the trap is set.

Trap Severity Specifies a severity level to assign to the trap. Open the pull-down 
menu and choose a level. Traps must be enabled to access this 
pull-down menu. Trap severity levels include Unknown, Emergency, 
Alert, Critical, Error, Warning, Notify, Info, Debug, and Mark
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4.6.5

Reinitializing the Configuration File System
If the Heartbeat LED on the switch is the 4-blink pattern, the configuration file 
system may be corrupted. To recover the previous switch configuration, use the 
Config Restore command. The Heartbeat LED 4-blink pattern continues until a 
previous switch configuration is successfully restored. The Heartbeat LED is not 
reflected in the SANbox Manager.

4.7

Archiving a Switch
You can create an .XML archive file containing the configuration parameters. 
Archived parameters include the following:

■ Switch properties and statistics

■ IP configuration

■ SNMP configuration

■ Port properties and statistics

■ Zoning configuration

This archive file can be used to restore the configuration on the same switch or on 
a replacement switch. You can also use the archive file as a template for 
configurring new switches to add to a fabric. Security settings and user account 
information are not archived. The archive can be used later to restore the switch. 
Refer to ”Restoring a Switch” on page 4-16 for more information. To archive a 
switch, do the following:

1. Open the Switch menu and select Archive. 

2. In the Save window, enter a file name.

3. Choose the Save button.
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4.8

Restoring a Switch
Restoring a switch loads the archived switch configuration parameters to the 
switch. The switch configuration must be archived before it can be restored. 
Refer to ”Archiving a Switch” on page 4-15 for more information.

It is good practice to archive and restore configurations from like switches. This 
means restoring a SANbox2-16 switch with a SANbox2-16 archive file, or 
restoring a SANbox2-8c with a SANbox2-8c archive file. If it is necessary to 
restore a switch with a dissimilar archive file, consider the following:

■ If you restore a SANbox2-8c switch with a SANbox2-16 archive file, the 
configuration for ports 0-7 on the SANbox2-8c switch will be restored. 
Archive information for ports 8-15 will be ignored.

■ If you restore a SANbox2-16 switch with a SANbox2-8c archive file, the 
configuration for ports 0-7 on the SANbox2-16 switch will be restored. Ports 
8-15 wil be unchanged.

The Restore menu item is not available for the inband switches. You can only 
restore a switch out-of-band (the fabric management switch). To restore a switch, 
do the following:

1. Open the Switch menu and select Restore. 

2. In the Restore window, enter the switch configuration file name or browse for 
the file. 

3. Choose the Restore button.

4.9

Loading Firmware
The switch does not have to offline to download firmware. However, the switch 
must be reset to activate the new firmware, which does require admin authority. 
SANbox Manager will prompt you to reset the switch after the firmware is loaded. 
The To load firmware to a switch, do the following:

1. In the faceplate display, open the Switch menu and select Load Firmware. 

2. In the Firmware Upload window, choose the Select button to browse and 
select the firmware file to be uploaded. 

3. Choose the Start button to begin the firmware load process. 

4. When the loading is complete, choose the Close button to close the 
Firmware Upload window.

5. The application prompts you to reset the switch. Choose the OK button to 
reset the switch and implement the new firmware.
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4.10

Restoring the Factory Default Configuration
You can restore the switch and port configuration settings to the factory default 
values. To restore the factory configuration on a switch, open the Switch menu 
and select Restore Factory Defaults. Table 4-8 lists the factory default switch 
configuration settings. Restoring the switch to the factory default configuration 
does not restore the account name and password settings. You must use the 
Reset Password File button in the Force PROM Mode screen. Refer to 
Recovering a Switch section in the SANbox2-8c Fibre Channel Switch Installation 
Guide or SANbox2 Fibre Channel Switch Installer’s/User’s Manual.

Table 4-8. Factory Default Configuration Settings

Setting Value

Chassis name SANbox2

Administrative state Online

Domain ID 1

Resource Allocation Timeout (RA TOV) 10000 milliseconds

Receiver Transmitter Timeout (RT TOV) 100 milliseconds

Error Detect Timeout (ED TOV) 2000 milliseconds

IP address 10.0.0.1

Subnet mask address 255.0.0.0

Gateway address 10.0.0.254

Boot method Static

Contact Undefined

Location Undefined

Trap address 127.0.0.1

Trap community Public

Read community Public

Write community Private

Port state Online

Port speed Auto-detect

Port mode GL
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Section 5
Managing Ports

This section describes the following tasks that manage ports and devices:

■ Displaying port information

■ Configuring ports

■ Testing Ports

5.1

Displaying Port Information
Port information is available primarily in the faceplate display shown in Figure 5-1. 
The faceplate display data windows provide information and statistics for switches 
and ports. Use the topology display to show the status information for links 
between switches.

Figure 5-1.  Faceplate Display - Port Information
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5.1.1

Monitoring Port Status
The faceplate display provides the following port related information:

■ Port mode

■ Port operational state

■ Port speed

■ Port media

To display port number and status information for a port, position the cursor over a 
port on the faceplate display. The status information changes depending on the 
View menu option selected.

5.1.1.1

Displaying Port Modes
To display port mode status, from the faceplate display, open the View menu, and 
select View Port Modes. Table 5-1 lists the possible port modes and their 
meanings.

Table 5-1. Port Modes

Mode Description

F Fabric port

FL Fabric loop port

TL Translated loop port

G Generic port

GL Generic fabric loop port

E Expansion port

D Donor port
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5.1.1.2

Displaying Port Operational States
To display the operational state on each port in the faceplate display, open the 
View menu and select View Port States. Table 5-2 lists the possible operational 
states and their meanings. The port operational state refers to actual port state 
and not the administrative state you may have assigned.

5.1.1.3

Displaying Port Speeds
To display the speed of each port in the faceplate display, open the View menu 
and select View Port Speeds. Table 5-3 lists the possible speeds.

Table 5-2. Port Operational States

State Description

On Online - port is active and ready to send data. 

Ia Inactive - port operational state is offline, but administrative state is 
online. 

Off Offline - port is active, can receive signal, but cannot accept a device 
login. 

Tst Test - port is active and being tested.

Dn Down – the port is inactive or shut off, not receiving a signal, and can’t 
be logged in.

Table 5-3. Port Speeds

State Description

1Gb A 1 Gbps transmission speed.

2Gb A 2 Gbps transmission speed.
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5.1.1.4

Displaying Tranceiver Media Status
To display transceiver media status, open the View menu and select View Port 
Media. Table 5-2 lists the possible media states and their meanings.

5.1.2

Port Statistics Data Window
The Port Statistics data window displays statistics about port performance. To 
open the Port Statistics window, select one or more ports in the faceplate display 
and choose the Port Statistics tab below the data window. Table 5-5 describes 
the Port Statistics data window entries.

The Statistics pull-down menu is available on the Port Statistics data window, and 
provides different ways to view detailed port information. Choose the down arrow 
to open the pull-down menu. Open the pull-down menu and select Absolute to 
view the total count of statistics since the last switch reset. Select Rate to view the 
number of statistics counted per second over the polling period. Select Baseline 
to view the total count of statistics since the last time the baseline was set. When 
viewing baseline statistics, choose the Clear Baseline button to set the current 
baseline.

Table 5-4. Transceiver Media View

Media Icon Description

Optical SFP, Online (Green)

Optical SFP, Offline (Gray)

None Empty port, no transceiver installed

Table 5-5. Port Statistics Data Window Entries 

Entry Description

Start Time The beginning of the period over which the statistics apply. The 
start time for the Absolute view is not applicable. The start time 
for the Rate view is the beginning of polling interval. The start 
time for the Baseline view is the last time the baseline was set.

End Time The last time the statistics were updated on the display.

Total Time Total time period from start time to end time.

Login Count Number of logins that have occurred on the switch.
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Logout Count Number of logouts that have occurred on the switch.

Al Init Count Number of times the port entered the initialization state.

Invalid Destination 
Address

Number of address identifiers (S_ID, D_ID) found to be in 
error.

Total LIP Received Number of loop initialization primative frames received.

LIP F7F7 Count A loop initialization primative frame used to acquire an AL_PA.

LIP F8F7 Count Currently not used.

LIP F7AIPs Count This LIP is used to reinitialize the loop. An L_port, identified by 
AL_PS, may have noticed a performance degradation and is 
trying to restore the loop.

LIP F8AIPs Count This LIP denotes a loop failure detected by the L_port 
identified by AL_PS.

LIP AIPdAIPs Count Number of F7, AL_PS LIPs, or AL_PD (vendor specific) resets, 
performed.

Class 2 In Frames Number of class 2 frames received by this port.

Class 2 Out Frames Number of class 2 frames transmitted by this port.

Class 2 Words In Number of class 2 words received by this port.

Class 2 Words Out Number of class 2 words transmitted by this port.

Class 3 In Frames Number of class 3 frames received by this port.

Class 3 Out Frames Number of class 3 frames transmitted by this port.

Class 3 Words In Number of class 3 words received by this port.

Class 3 Words Out Number of class 3 words transmitted by this port.

Decode Error Count Number of invalid transmission words detected during 
decoding. Decoding is from the 10-bit characters and special K 
characters.

Loss Of Sync Count Number of synchronization losses (>100 ms) detected by this 
port. A loss of synchronization is detected by receipt of an 
invalid transmission word.

Invalid CRC Count Number of invalid Cyclic Redundancy Check (CRC) frames 
detected.

Tx Wait Count Number of times the port entered a wait state because it was 
out of buffer-to-buffer credits.

Table 5-5. Port Statistics Data Window Entries (Continued)

Entry Description
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Class 3 Toss Count Number of class 2 and class 3 sequences that were discarded 
by this port. A sequence can be discarded because of 
detection of a missing frame (based on SEQ_CNT), detection 
of an E_D_TOV timeout, receiving a reject frame, receiving 
frames for a stopped sequence, or other causes.

FReject Count Number of frames, from devices, that have been rejected. 
Frames can be rejected for any of a large number of reasons.

FBusy Count Number of class 2 and class 3 fabric busy (F_BSY) frames 
generated by this port in response to incoming frames. This 
usually indicates a busy condition on the fabric or N_port that 
is preventing delivery of this frame.

Link Failures Number of optical link failures detected by this port. A link 
failure is a loss of synchronization for a period of time greater 
than the value of R_T_TOV or by loss of signal while not in the 
offline state. A loss of signal causes the switch to attempt to 
re-establish the link. If the link is not re-established by the time 
specified by R_T_TOV, a link failure is counted. A link reset is 
performed after a link failure.

Primitive Sequence 
Errors

Number of bad primitives received by the port.

Rx Link Resets Number of link reset primatives received from an attached 
device.

Tx Link Resets Number of link reset primatives sent from this port to an 
attached port.

Rx Offline Sequences Number of offline sequence primitives received by the port.

Tx Offline Sequences Number of offline primitives transmitted by the port.

Total Errors Total number of primitive and non-primitive port link errors.

Total Tx Frames Total number of frames transmitted by the port.

Total Rx Frames Total number of frames received by the port.

Total Tx Words Total number of words transmitted by the port.

Total Rx Words Total number of words received by the port.

Total Link Resets Number of link-reset primitives the transmitted by the port.

Total Offline 
Sequences

Total number of offline sequences transmitted and received by 
the port.

Table 5-5. Port Statistics Data Window Entries (Continued)

Entry Description
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5.1.3

Port Information Data Window
The Port Information data window displays port detail information for the selected 
port. To open the Port Information data window, choose the Port Info tab below 
the data window in the faceplate display.

Table 5-6. Port Info Data Window Entries

Entry Description

Admin Port Mode The port mode before auto-configuration 
occurs.

Oper Port Mode The current port mode.

Admin Port State The port state before auto-configuration 
occurs.

Oper Port State The current port state.

Loop Enabled A setting to allow arbitrated loop 
configuration.

Logged In Indicates whether logged in or not.

E Port Connection Status Whether E Port connection is enabled.

E Port Isolation Status Why E Port is isolated. 

MFS Mode Port tuning indicator.

I/O Stream Guard Whether RSCN suppression is enabled or 
disabled.

Admin Port Speed The speed requested by the user.

Oper Port Speed The speed actually being used by the port.

TLMode Indicates if TL target or TL initiator is being 
used.

BB Credits Whether buffer-to-buffer credits have been 
set.

Ext Credits Requested Whether extended credits have been 
requested for ports.

Medium The transceiver type. 



5 – Managing Ports
Configuring Ports

5-8 59022-03 D

�

5.1.4

Name Server Data Window
The Name Server data window displays information about the port and the 
connected device. To open the Name Server data window, select one or more 
switches in the topology display and choose the Name Server tab below the data 
window. You can also open the Name Server data window in the faceplate display. 
Refer to Table 4-1 for a description of the Name Server data window entries.

5.2

Configuring Ports
The port settings or characteristics are configured using the Port Properties 
window shown in Figure 5-2. To open the Port Properties window, select one or 
more ports, open the Port menu and select Port Properties.

Figure 5-2.  Port Properties Window

The Port Properties window displays the switch name and the selected port(s). 
Use the Port Properties window to change the following parameters:

■ Port state

■ Port speed

■ Port mode

■ TL mode

■ Port buffer credits

■ I/O Stream Guard (RSCN Suppression)
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5.2.1

Changing Port Administrative States
The port administrative state determines the port operational state. The port 
administrative state refers to the requested state in the SANbox Manager 
application or through the CLI; the port operational state refers to the state 
actually being used by the port. Table 5-7 describes the port administrative states. 
To change port administrative state, do the following:

1. Select one or more ports in the faceplate display.

2. Open the Port menu and select Port Properties to open the Port Properties 
window.

3. Choose the Port States radio button for the the port state you want.

4. Choose the OK button to write the new port state to the switch.

5.2.2

Changing Port Speeds
The SANbox2 switch ports are capable of transmitting and receiving at 1 or 2 
Gbps. The ports can be configured for either transmission speed or to sense the 
transmission speed of the device to which it is connected. Table 5-8 describes the 
port speeds. To change the port speed, do the following:

1. Select one or more ports in the faceplate display.

2. Open the Port menu and select Port Properties.

3. Choose the radio button that corresponds to the port speed you want.

4. Choose the Apply button to write the new port speed to the switch.

Table 5-7. Port Administrative States

State Description

Online Activates and prepares port to send data. 

Offline Permits port to remain active, but prevents port from receiving signal 
and accepting a device login. 

Test Permits port to remain active, but prepares port for testing.
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5.2.3

Changing Port Modes
The SANbox2 switch ports support both public and private devices as single 
devices or in loops. The ports can be configured to self-discover the proper mode 
to match the device or switch to which it is connected. Table 5-9 describes the port 
modes. To change the port mode, do the following:

1. Select one or more ports in the faceplate display.

2. Open the Port menu and select Port Properties to open the Port Properties 
window.

3. Choose the Port Modes radio button that corresponds to the port mode you 
want.

4. Choose the OK button to write the new port mode to the switch.

Table 5-8. Port Speeds

State Description

Auto-Detect Matches the transmission speed of the connected device. This is the 
default. 

1Gb Sets the transmission speed to 1 Gbps.

2Gb Sets the transmission speed to 2 Gbps.

Table 5-9. Port Modes

State Description

F_Port Fabric port - Supports a single public device (N_Port).

FL_Port Fabric loop port - Supports a loop of up to 126 public devices (NL_Port).

TL_Port Translated loop port - Supports a loop of up to 126 private target or 
initiator devices capable of communicating with up to 63 public or private 
devices on other ports. Refer to the Installation Guide for your switch for 
more information about TL_Ports.

G_Port Generic port - Self discovers as an F_Port or an E_Port.

GL_Port Generic loop port - Self discovers as an F_Port, FL_Port, or an E_Port.

Donor Donor port - Allows buffer credits to used by another port.
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5.2.4

Changing TL Modes
You can configure a TL_Port to support a loop of private target devices or a loop 
of private initiator devices. 

■ For a loop of private target devices, choose the TL Target radio button. This 
enables up to 63 initiator devices anywhere in the fabric to automatically 
connect with the private devices on the TL_Port. Use zoning to limit the 
number of possible initiators to 63.

■ For a loop of private initiator devices, choose the TL Initiator radio button. 
This enables the private initiators on the TL_Port to automatically connect to 
up to 63 target devices. The TL_Port initiator devices and the target devices 
must be members of the same soft zone.

5.2.5

Changing Buffer-to-Buffer Credits
Each SANbox2 port has a receive buffer capacity of 12 Fibre Channel frames or 
credits which is equal to approximately 24K bytes. Port buffer credits can be 
changed on ports to accommodate connections to non-SANbox2 switches that 
have different port buffer capacities. To change port buffer credits, do the 
following:

1. Select one or more ports in the faceplate display.

2. Open the Port menu and select Port Properties.

3. In the E_Port BB Credits field, enter the new number.

4. Choose the OK button to write the new buffer-to-buffer setting to the switch.

5.2.6

I/O Stream Guard
The I/O Stream Guard feature suppresses Registered State Control Notification 
(RSCN) messages on a port basis.

5.2.7

Extending Port Credits
Each port is supported by a data buffer with a 12 credit capacity; that is, 12 
maximum sized frames. For fibre optic cables, this enables full bandwidth class 2 
service over a distance of 20 kilometers at 1 Gbps (0.6 credits/Km), or 10 
kilometers at 2 Gbps (1.2 credits/Km). Longer distances can be spanned at full 
bandwidth by borrowing credits from designated donor ports thus pooling the 
buffer capacities. This is called credit extension. Each donor port contributes 11 
credits to the pool from which the recipient ports can draw. For example, one 
donor port contributes 11 credits to the pool from which a recipient draws for a 
total of 23 credits (11+12). This provides approximately 38 Km at 1 Gbps (23÷0.6) 
or 19 Km at 2 Gbps (23÷1.2).
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To extend port buffer credits, do the following:

1. In the faceplate display, select the ports that are to serve as donor ports. 
Open the Port menu and select Port Properties. In the Port Properties 
window, choose the Donor radio button and choose OK.

2. In the faceplate display, select the recipient ports. Recipient ports must be 
configured as G_Ports or F_Ports. Open the Port menu and select 
Extended Credits. This opens the Extended Credits window shown in 
Figure 5-3.

3. Distribute the borrowed credits by incrementing the Ext Credits Requested 
field for the recipient ports up to the total credits in the pool. If you exceed 
this total, some recipient ports will not receive the requested credits. Choose 
OK.

Figure 5-3.  Extended Credits Window

Note: Donor ports are incapable of transmitting or receiving data.

Note: As credits are used, the Logged-In LEDs on the corresponding donor 
ports illuminate continuously. In addition, donor port Activity LEDs will 
reflect the same traffic as the recipient port. Donor ports whose credits 
are being used are unavailable to devices that are connected to them.
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5.2.8

Resetting a Port
The Reset Port option reinitializes the port using configuration parameters in 
memory. To reset a port, do the following:

1. In the Faceplate Display, select the port(s) to be reset. 

2. Open the Port menu and select Reset Port.

5.3

Testing Ports
The port loopback tests verify correct port operation by sending a frame out 
through the loop, and then verifying that the frame received matches the frame 
that was sent. Only one port can be tested at a time for each type of test. The 
three types of port loopback tests are: 

■ SerDes level (Internal) - The SerDes level test verifies port circuitry. The 
SerDes level test sends a test frame from the ASIC through the SerDes chip 
and back to the ASIC for the selected ports. The port passes the test if the 
frame that was sent by the ASIC matches the test frame that was received.

■ SFP level (External) - The SFP level test also verifies port circuitry. The 
SFP level test sends a test frame from the ASIC through the SerDes chip, 
through the SFP transceiver fitted with a loopback plug, and back to the 
ASIC for the selected ports. The port passes the test if the test frame that 
was sent by the ASIC matches the test frame that was received.

■ Node-to-Node (Online) - The Node-to-Node test verifies communications 
between the port and its device node or device loop. The port being tested 
must be online and connected to a remote device. The port passes the test if 
the test frame that was sent matches the test frame that was received.

Figure 5-4.  Port Loopback Test Window
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To run the Internal, External, or Online port loopback test on a port, do the 
following:

1. In the faceplate display, select the port to be tested.

2. Open the Port menu and select Port Loopback Test to open the Port 
Loopback Test window.

3. In the Test Selection area, choose the radio button for the type of loopback 
test (Internal, External, or Online) to be run. 

■ If you choose the Internal or External test, SANbox Manager will 
prompt you to confirm that the state of the port being tested needs to 
be changed to the Test (diagnostic) state in order to run the test. 
Choose the OK button and SANbox Manager will change the port 
state. In the Port Loopback Test window, choose the Start Test button 
to begin the test. 

■ If you choose the Online test, the fields in the Test Parameters area 
are activated. Enter the frame count, frame size, and choose a test 
pattern radio button. You may use the default pattern or enter a 
user-specified pattern (hex). Check the Terminate Test Upon Error 
box if you want the test to stop when encountering an error. Choose 
the Start Test button to begin the test.

4. The Test Results area displays the test status, number of frames sent, and 
number of errors found.

5. To test another port, open the Select Port pull-down menu and select 
another port (number) and test type (Internal, External, or Online) in the Test 
Selection area. 

6. Choose the Start Test button to begin the next test. Observe the results in 
the Test Results area.

Note: The SerDes (Internal) and SFP (External) level tests disrupt 
communication on the selected port. The Node-to-Node (Online) level 
test does not disrupt communication, because the requires that the port 
be online.



59022-03 D A-1

Appendix A
Command Line Interface

Each SANbox2 switch contains a Telnet server. This server allows a Telnet client 
to establish a Telnet session with the switch to retrieve information or to configure 
parameters. The Command Line Interface enables you to perform a variety of 
fabric and switch management tasks through an Ethernet or a serial port 
connection to a switch.

A.1

Logging On to a Switch
To log on to a switch using Telnet, open a command line window on the 
management workstation and enter the Telnet command followed by the switch IP 
address:

/> telnet 123.45.67.890

A Telnet window opens prompting you for a SANbox2 login. Enter an account 
name and password. Switches come from the factory with the following user 
account already defined:

Account name: admin
Password: password
Authority: Admin

This user account provides full access to the switch and its configuration. After 
planning your fabric management needs and creating your own user accounts, 
consider changing the password for this account. Refer to ”Commands” on 
page A-3 for more information about authority levels. Refer to the ”User 
Command” on page A-59 for information about creating and deleting user 
accounts.

Note: The switch supports a combined maximum of 15 logins. This includes 
SANbox Manager inband and out-of-band logins, Telnet out-of-band 
logins, and SNMP out-of-band logins. Additional logins will be refused.



A – Command Line Interface
Command Syntax

A-2 59022-03 D

�

A.2

Command Syntax
The command syntax is as follows:

command
keyword
keyword [value]
keyword [value1] [value2]

The Command is followed by one or more keywords. Consider the following rules 
and conventions:

■ Commands and keywords are lowercase and case sensitive.

■ Commands with keywords require one of those keywords.

■ Required keyword values appear in standard font: [value]. Optional values 
are shown in italics: [value].

■ Underlined portions of the keyword in the command format indicate the 
abbreviated form that can be used. For example the Delete keyword can be 
abbreviated Del.
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A.3

Commands
The command set provides for User and Admin authority levels.

■ User authority grants viewing access to the fabric and switches using the 
Show command and other read-only commands.

■ Admin authority includes the User authority and grants permission to use the  
Admin command. The Admin Start command opens an admin session which 
provides access to the commands that change switch and fabric 
configurations. Refer to the ”Admin Command” on page A-4.

The commands and their page numbers are listed by authority level in Table A-1.

Note: Admin authority is enforced only if fabric security is enabled on 
the switch. By default, fabric security is disabled. Refer to the 
System keyword of the ”Set Setup Command” on page A-34 for 
information about setting fabric security.

Table A-1. Commands Listed by Authority Level

User Authority Commands Admin Authority Command

Date
Help
History
Ps
Quit
Set Beacon
Show
Show Config
Show Log
Show Perf
Show Setup
Uptime
Whoami

(A-9)
(A-11)
(A-12)
(A-16)
(A-17)
(A-23)
(A-39)
(A-48)
(A-50)
(A-52)
(A-53)
(A-58)
(A-61)

Admin (A-4)

Admin Session Commands

Alias1

Config1

Fallback
Image
Lip
Passwd
Reset
Set Alarm Clear
Set Config
Set Log
Set Port
Set Setup
Set Switch
Shutdown
Test
User1

Zone1

Zoneset1

Zoning1

1Some keywords are available with User authority outsiide of an admin session.

(A-5)
(A-7)
(A-10)
(A-13)
(A-14)
(A-15)
(A-18)
(A-22)
(A-24)
(A-30)
(A-33)
(A-34)
(A-38)
(A-55)
(A-56)
(A-59)
(A-62)
(A-65)
(A-67)
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Admin Command
Opens and closes an Admin session granting Admin authority. The Admin session 
provides commands that change the fabric and switch configurations. Only one 
Admin session can be open in the fabric at any time. An inactive Admin session 
will time out after a period of time which can be changed using the Set Setup 
System command. Refer to the Set Setup Command on page A-34.

Authority Admin

Syntax admin
start
end
cancel

Keywords start
Opens the Admin session.

end
Closes the Admin session.

cancel
Terminates an Admin session opened by another user. Use this keyword with care 
because it terminates the Admin session without warning the other user and 
without saving pending changes.

Examples The following example shows how to open and close an Admin session:

SANbox2 $> admin start

SANbox2 (admin) #>

.

.

.

SANbox2 (admin) #> admin end

SANbox2 #>
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Alias Command
Creates a named set of ports. Aliases make it easier to assign a set of ports to 
many zones. An alias can not have a zone or another alias as a member. 

Authority Admin

Syntax alias
add [alias] [members]
copy [alias_source] [alias_destination]
create [alias]
delete [alias]
list
members [alias]
remove [alias] [members]
rename [alias_old] [alias_new]

Keywords add [alias] [members]
Specifies one or more ports given by [members] to add to the alias named [alias]. 
[members] can have one of the following formats:

■ Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.

■ 6-character device Fibre Channel address (hex)

■ 16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.

The application verifies that the [alias] format is correct, but does not validate that 
such a port/device exists.

copy [alias_source] [alias_destination]
Creates a new alias named [alias_destination] and copies the membership into it 
from the alias given by [alias_source].

create [alias]
Creates an alias with the name given by [alias]. The alias name can have a 
maximum of 64 characters.

delete [alias]
Deletes the specified alias given by [alias] from the zoning database. If the alias is 
a member of the active zone set, the alias will not be removed from the active 
zone set until the active zone set is deactivated.

list
Displays a list of all aliases. This keyword is valid for User authority and does not 
require a zoning edit session or an admin session. 

members [alias]
Displays all members of the alias given by [alias]. This keyword is available with 
User authority and does not require a zoning edit session or an admin session.
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remove [alias] [members]
Removes the ports given by [members] from the alias given by [alias]. [members] 
can have one of the following formats:

■ Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.

■ 6-character device Fibre Channel address (hex)

■ 16-character hexadecimal worldwide port name (WWPN) for the device with 
the format xx:xx:xx:xx:xx:xx:xx:xx.

rename [alias_old] [alias_new]
Renames the alias given by [alias_old] to the alias given by [alias_new].
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Config Command
Manages the Fibre Channel configurations on a switch. For information about 
setting the port and switch configurations, refer to the ”Set Config Command” on 
page A-24.

Authority Admin for all keywords except List

Syntax config
activate [config]
backup
cancel
copy [config_source] [config_destination]
delete [config]
edit [config]
list
restore
save [config]

Keywords activate [config]
Activates the configuration given by [config]. If you omit the configuration, the 
currently active configuration is used. SANbox2 supports up to 10 configurations 
(only one can be active at a time).

backup
Creates a file named configdata, which contains the system configuration 
information. This file should be downloaded from the switch using FTP and stored 
in a safe place. 

cancel
Terminates the current configuration edit session without saving changes that 
were made.

copy [config_source] [config_destination]
Copies the configuration given by [config_source] to the configuration given by 
[config_destination].

delete [config]
Deletes the specified configuration file where [config] is a file name.

edit [config]
Opens the an edit session for the configuration given by [config]. If you omit the 
configuration name, the currently active configuration is used. SANbox2 supports 
up to 10 configurations (only one can be active at a time). 

list
Displays a list of all available configurations. This keyword is available with User 
authority.

restore
Restores configuration settings to the switch from a backup file named configdata, 
which must be first uploaded on the switch using FTP. You create the backup file 
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using the Config Backup command. Use FTP to load the backup file on a switch, 
then enter the Config Restore command.

save [config]
Saves changes made during a configuration edit session in the configuration 
given by [config]. If you omit the configuration name value, the configuration you 
chose for the Config Edit command is used.

Notes If you edit the active configuration, changes will be held in suspense until you 
reactivate the configuration or activate another configuration.

Examples The following shows an example of how to open and close a Config Edit session:

SANbox2 $> admin start

SANbox2 (admin) #> config edit

.

.

.

SANbox2 (admin-config) #> config cancel

  Configuration mode will be canceled.Please confirm (y/n): [n] y

SANbox2 (admin) #> admin end

SANbox2 $>                              
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Date Command
This command displays or sets the system date and time. To set the date and time 
the information string must be provided in this format: MMDDhhmmCCYY.

Authority Admin

Syntax date
[MMDDhhmmCCYY]

Keywords [MMDDhhmmCCYY]
Specifies the date. If you omit the keyword value, the current date is displayed.

Examples The following is an example of the Date command:

SANbox2 $> date

  Tue Jun 12 07:51:24 2001
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Fallback Command
Loads the fallback version of the firmware from switch memory. The switch stores 
two versions of the firmware. This command alternately activates the two 
versions.

Authority Admin

Syntax fallback

Notes ■ The Show Switch command displays the available firmware versions and 
the currently active version.

■ After executing the Fallback command, reset the switch for the firmware to 
placed in effect.

Examples The following is an example of the Fallback command:

SANbox2 $> admin start

SANbox2 (admin) #> fallback

  Reverting to previous software image.  Please confirm (y/n): [n] y

SANbox2 $> admin end

SANbox2 $>
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Help Command
Displays a brief description of the specified command and its keywords.

Authority User

Syntax help [command] [keyword]

Keywords [command]
A command name. If you omit this value, the system displays all available 
commands from which to choose.

[keyword]
A keyword associated with the command named by [command]. If you omit this 
value, the system displays the available keywords for the specified command.

all
Displays a list of all available commands (including command variations).

Examples The following is an example of the Help Set command:

SANbox2 $> help set

set SET_OPTIONS

There are many attributes that can be set.

Type help with one of the following to get more information:

    set beacon

    set config port

    set config ports

    set config switch

    set log

    set port

    set setup snmp

    set setup system

    set switch

The following is an example of the Help Set Beacon command:

SANbox2 $> help set beacon

set beacon On | Off

This command allows the lights on the front of the switch to flash.

The On option will start and the Off option will stop the flashing.
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History Command
Displays a numbered list of the previously entered commands from which you can 
re-execute selected commands.

Authority User

Syntax history

Notes Use the History command to provide context for the ! command:

■ Enter ![command] to re-enter the most recent execution of that command.

■ Enter ![line number] to re-execute the corresponding command from the 
History display

■ Enter ![partial command string] to re-execute a command that matches the 
command string.

■ Enter !! to re-execute the most recent command.

Examples The following is an example of the History command:

SANbox2 $> history

   1 show switch

   2 date

   3 help set

   4 history

SANbox2 $> !3

help set

set SET_OPTIONS

There are many attributes that can be set.

Type help with one of the following to get more information:

    set beacon

    set config port

    set config ports

    set config switch

    set log

    set port

    set setup snmp

    set setup system

    set switch
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Image Command
Manages and installs switch firmware.

Authority Admin

Syntax image
cleanup
fetch [account_name] [ip_address] [file_source] [file_destination]
list
unpack [file]

Keywords cleanup
Removes the firmware image file from the switch. The firmware image file is 
removed automatically each time the switch is reset.

fetch [account_name] [ip_address] [file_source] [file_destination]
Retrieves image file given by [file_source] and stores it on the switch with the file 
name given by [file_destination]. The image file is retrieved from the device with 
the IP address given by [ip_address] and an account name given by 
[account_name]. If an account name needs a password to access the device, the 
system will prompted you for it.

list
Displays the list of image files that reside on the switch.

unpack [file]
Installs the firmware file given by [file]. After unpacking the file, a message 
appears confirming successful unpacking. The switch must be reset for the new 
firmware to take effect.



A – Command Line Interface
Lip Command

A-14 59022-03 D

�

Lip Command
Reinitializes the specified loop port.

Authority Admin

Syntax lip [port_number]

Keywords [port_number]
The number of the port to be reinitialized.

Examples The following is an example of the Lip command:

SANbox2 (admin) #> lip 2
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Passwd Command
Changes a user account’s password.

Authority Admin

Syntax passwd [account_name]

Keywords [account_name]
The user account name.

Examples The following is an example of the Passwd command:

SANbox2 (admin) #> passwd user2

      Press ’q’ and the ENTER key to abort this command.

  account OLD password               :

  account NEW password (4-20 chars)  :

  please confirm account NEW password:

  password has been changed.
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Ps Command
Displays current system process information.

Authority User

Syntax ps

Examples The following is an example of the Ps command:

SANbox2 $> ps

PID  PPID %CPU     TIME     ELAPSED COMMAND

298   292  0.0 00:00:00 59:42       cns

299   292  0.0 00:00:00 59:42       ens

300   292  0.0 00:00:00 59:42       dlog

301   292  0.3 00:00:53 59:42       ds

302   292  0.2 00:00:29 59:42       mgmtApp

303   292  0.0 00:00:02 59:42       nserver

304   292  0.0 00:00:00 59:42       mserver

305   292  0.1 00:00:15 59:42       util

306   292  0.0 00:00:04 59:42       eport

307   292  1.2 00:02:53 59:41       PortApp

308   292  0.0 00:00:01 59:41       zoning

309   292  0.0 00:00:00 59:41       diagApp



A – Command Line Interface
Quit Command

59022-03 D A-17

�

Quit Command
Closes the Telnet session.

Authority User

Syntax quit, exit, or logout
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Reset Command
Resets the switch and port configuration parameters. 

Authority Admin

Syntax reset
config
factory
port [port_number]
snmp
switch (default)
system
zoning

Keywords config
Resets the configuration settings for the switch and its ports to the factory default 
values. Refer to Table A-2 and Table A-3 for switch and port configuration default 
values.

factory
Resets switch, port, SNMP, and system configuration settings to the factory 
default values. Refer to Table A-2 through Table A-5.

port [port_number]
Reinitializes the port given by [port_number]. Ports are numbered beginning with 
0.

snmp
Resets the SNMP configuration settings to the factory default values. Refer to 
Table A-4for SNMP configuration default values.

switch
Reinitializes the switch. This command also closes the Telnet session.

system
Resets the system configuration settings to the factory default values. Refer to 
Table A-5 for system configuration default values.

zoning
Resets the zoning configuration settings to the factory default settings. This 
keyword clears all zoning definitions on the switch.
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Notes The following tables specify the various factory default settings:

Table A-2. Switch Configuration Defaults

Parameter Default

Admin State Online

Broadcast Enable False

Domain ID 1

Domain ID Lock True

Symbolic Name SANbox2

R_T_TOV 100

R_A_TOV 10000

E_D_TOV 2000

FS_TOV 5000

DS_TOV 5000

Principal Priority 254

Description Undefined

Table A-3. Port Configuration Defaults 

Parameter Default

Admin State Online

Link Speed Auto

Port Type GL

TL_Port Mode True

ISL Security Any

Symbolic Name Port

ALFairness False

ARB_FF False

InteropCredit 0

ExtCredit 0

FanEnable True
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LCFEnable False

MFSEnable False

MFS_TOV 640

MSEnable True

NoClose False

IOStreamGuard False

VIEnable False

CheckAlps False

Table A-4. SNMP Configuration Defaults

Parameter Default

Contact Undefined

Location Undefined

Description Undefined

Trap [1-5] Enabled False

Trap [1-5] Address 127.0.0.1

Trap [1-5] Port Undefined

Trap [1-5] Severity Warning

ObjectID 1663.1.1.1.1.111.3.6.1.4.1

AuthFailureTrap False

Table A-3. Port Configuration Defaults (Continued)

Parameter Default
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Table A-5. System Configuration Defaults

Parameter Default

Network IP Address 10.0.0.1

Network IP Mask 255.0.0.0

Gateway Address 10.0.0.254

Network Discovery Static

Admin Timeout 30 minutes

Security Enabled False

Remotelog Enabled False

LogHost IP Address Undefined 
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Set Alarm Clear Command
Clears the log (list) of alarms.

Authority User

Syntax set alarm clear

Examples The following example clears the list of alarms.

SANbox2 $> set alarm clear
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Set Beacon Command
Assists in locating a switch by causing all port Logged-In LEDs on the switch to 
flash.

Authority User

Syntax set beacon [state]

Keywords [state]
Enables or disables the flashing of the port Logged-In LEDs according to [state].

On
Enables the flashing beacon.

Off
Disables the flashing beacon.

Examples The following examples enables and disables the beacon:

SANbox2 $> set beacon on

  Command succeeded.

SANbox2 $> set beacon off

  Command succeeded.
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Set Config Command
Sets switch, port, and zoning configuration parameters.

Authority Admin authority within a Config Edit session

Syntax set config
port [port_number]
ports [port_number]
switch
zoning

Keywords port [port_number]
Changes configuration parameters for the port number given by [port_number]. If 
you omit this value, the system begins with port 0 and proceeds in order through 
port 15 or until you enter “qq”. The system displays each parameter one line at a 
time and prompts you for a value. For each parameter, enter a new value or press 
the Enter key to accept the current value shown in brackets.

ports [port_number]
Very similar to the Set Config Port command, except that any attribute value that 
is changed by the user is applied to ALL ports. ONLY attribute values that are 
changed are updated; the attribute values that are not changed are left alone. 
Ports are numbered beginning with 0. The default is port 0. The system displays 
each parameter one line at a time and prompts you for a value. For each 
parameter, enter a new value or press the Enter key to accept the current value 
shown in brackets. Admin and config edit modes are required for this command.

Table A-6. Set Config Port Parameters 

Parameter Description

AdminState Port administrative state: online, offline, 
diagnostics, or down

LinkSpeed 1Gb/sec or 2 Gb/sec

PortType Type of port

TLPortMode Initiates the configuration of ports 
attributes. Indicates whether using 
initiator or target devices on the loop. If 
[port_number] is specified then the user 
will be presented with attributes for that 
port only; otherwise, all attributes for all 
ports will be available for configuration. 
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ISLSecurity E_Port security. Determines which 
switches a port will establish a link with.
■  ANY - we will link with any switch. 
■ Ours - we will only link to another 

SANbox2 switch. 
■ None - the port will not establish an 

ISL link.

SymbolicPortName Descriptive name 

ALFairness Default is switch that has priority 

ARB_FF Use ARB_FF instead of idles on loop 
FCAL option 

InteropCredit Number of buffer-to-buffer credits per 
port. 0 means the default (12) is 
unchanged.

ExtCredit Extended credit port 

FANEnable Fabric Address Notification. If enabled, 
notifies logged-in NL_Ports of the 
FL_Ports’s address, port name, and 
node name. 

LCFEnable Link control frame preference, R_CTL = 
0xC 

MFSEnable Multi-Frame Sequence bundling 

MFS_TOV MFS limit for camp on 

MSEnable Management Server enable on this port

NoClose    Don't close unless another devices 
arbitrates

I/O Stream Guard Enables or disables the suppression of 
RSCN messages

VIEnable Enable VI preference routing

CheckAlps Close before sending frames to new 
target

Table A-6. Set Config Port Parameters (Continued)

Parameter Description
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switch
Initiates an editing session in which to change switch configuration settings. The 
system displays each parameter one line at a time and prompts you for a value. 
For each parameter, enter a new value or press the Enter key to accept the 
current value shown in brackets. 

Table A-7. Set Config Switch Parameters

Parameter Description

AdminState Switch administrative state: online, 
offline, or diagnostics.

Broadcast Enable Enables or disables (default) forwarding 
if broadcasting frames.

DefaultDomainID Default domain ID setting

DomainIDLock If set to True (default), prevents domain 
ID from being changed. 

SymbolicName Descriptive name 

R_T_TOV Receiver Transmitter Timeout Value. 
Specifies the number of milliseconds a 
port is to wait to receive a response 
from another port. The default is 100.

R_A_TOV Resource Allocation Timeout Value. 
The number of milliseconds the switch 
waits to allow two ports to allocate 
enough resources to establish a link. 
The default is 10000.

E_D_TOV Error Detect Timeout Value. The 
number of milliseconds a port is to wait 
for errors to clear. The default is 2000 
msec.

FS_TOV Fabric Stability Timeout Value. The 
default is 5000 msec.

DS_TOV Distributed Services Timeout Value 
(Management Server, Name Server). 
The default is 5000 msec.

PrincipalPriority The priority used in the FC-SW-2 
principal switch selection algorithm. 1 is 
high, 255 is low.

Description The name for the configuration. The 
default is undefined.
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zoning
Initiates an editing session in which to change switch zoning attributes. The 
system displays each parameter one line at a time and prompts you for a value. 
For each parameter, enter a new value or press the Enter key to accept the 
current value shown in brackets.

Examples The following is an example of the Set Config Port command:

SANbox2 $> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config port 1

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the default value.

  If you wish to terminate this process before reaching the end of the list

  press ’q’ or ’Q’ and the ENTER key to do so.

  Configuring Port Number:  1

  ------------------------

  AdminState    (1=Online, 2=Offline, 3=Diagnostics, 4=Down) [Online]

  LinkSpeed     (1=1Gb/s, 2=2Gb/s, 3=Auto)                   [Auto  ]

  PortType      (TL / GL / G / F / FL / Donor)               [GL    ]

  TLPortMode    (1=TLTargetMode, 2=TLInitiatorMode)          [TLInitiatorMode]

  ISLSecurity   (Any /  Ours / None)                         [Any   ]

  SymPortName   (string, max=32 chars)                       [Port2 ]

  ALFairness    (True / False)                               [False ]

Table A-8. Set Config Zoning Parameters

Parameter Description

AutoSave Determines whether zoning changes 
will be saved to flash (non-volatile) 
memory or to RAM (volatile) in each 
switch. The default is On.

Default Determines communication among 
ports/devices in the absence of an 
active zone set. “All” enables all 
ports/devices to communicate with one 
another. “None” prohibits 
communication among ports/devices. 

Merge Mode Enables SANbox2 switch to 
interoperate with switches running 
non-FC-SW-2 compliant firmware.
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  ARB_FF        (True / False)                               [False ]

  InteropCredit (decimal value, 0-255)                       [0     ]

  ExtCredit     (decimal value, 0-65535)                     [0     ]

  FANEnable     (True / False)                               [True  ]

  LCFEnable     (True / False)                               [False ]

  MFSEnable     (True / False)                               [False ]

  MFS_TOV       (decimal value, 10-20480 msec)               [640   ]

  MSEnable      (True / False)                               [True  ]

  NoClose       (True / False)                               [False ]

  I/O Stream Guard -                                                 

               (Suppress RSCN)(Enable / Disable)            [Disable]

  VIEnable      (True / False)                               [False ]

  CheckAlps     (True / False)                               [False ]

  

  Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.

The following is an example of the Set Config Switch command:

SANbox2 $> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config switch

  A list of attributes with formatting and default values will follow.

  Enter a new value or simply press the ENTER key to accept the default value.

  If you wish to terminate this process before reaching the end of the list

  press ’q’ or ’Q’ and the ENTER key to do so.

  AdminState         (1=Online, 2=Offline, 3=Diagnostics) [Online       ]

  BroadcastEnable    (True / False)                       [False        ]

  DefaultDomainID    (decimal value, 1-239)               [11           ]

  DomainIDLock       (True / False)                       [True         ]

  SymbolicName       (string, max=32 chars)               [bottom switch]

  R_T_TOV            (decimal value, 1-1000 msec)         [100          ]

  R_A_TOV            (decimal value, 100-100000 msec)     [10000        ]

  E_D_TOV            (decimal value, 10-20000 msec)       [2000         ]

  FS_TOV             (decimal value, 100-100000 msec)     [5000         ]

  DS_TOV             (decimal value, 100-100000 msec)     [5000         ]

  PrincipalPriority  (decimal value, 1-255)               [254          ]

  Description        (string, max=32 chars)               [             ]
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The following is an example of the Set Config Zoning command.

SANbox2 $> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config zoning

A list of attributes with formatting and current values will follow.

Enter a new value or simply press the ENTER key to accept the default value.

If you wish to terminate this process before reaching the end of the list

  press ’q’ or ’Q’ and the ENTER key to do so.

  AutoSave      (True / False)  [True]

  Default       (All / None)    [All ]

  Merge Mode    (Brocade / SW2) [SW2 ]

  

  Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.
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Set Log Command
Specifies the type of entries to be entered in the event log. The log is a storage file 
contained on the switch. The log can hold a maximum of 200 entries. When the 
log becomes full, the entries are replaced, starting with the oldest entry, to 
produce a list of the last 200 events which occurred. Log entries are created for 
ports, components, and event severity levels, based on the settings defined for 
the active configuration.

Authority Admin

Syntax set log
archive
clear
component [list]
level [level]
port [ports]
restore
save
start (default)
stop

Keywords archive
Archives the log entries to a file on the switch named logfile that can be 
downloaded from the switch using FTP. (FTP to the switch, log in with 
username/password of “images” for both, and type “get logfile”.) 

clear
Clears all log entries.

component [list]
Specifies one or more components to monitor for events. Use spaces to delimit 
values in the list. Choose one or more of the following values:

all
Monitors all components. To maintain optimal switch performance, do not 
use this setting with the Level keyword set to Info.

blade
Monitors modular circuit boards in cabinets, racks, and high-port-count 
switches.

chassis
Monitors chassis hardware components such as fans and power supplies.

eport
Monitors all E_Ports.

mgmtserver
Monitors management server status.

nameserver
Monitors name server status.



A – Command Line Interface
Set Log Command

59022-03 D A-31

�

none
Monitor none of the component events.

other
Monitors other miscellaneous events.

port
Monitors all port events

switch
Monitors switch management events.

Zoning
Monitors zoning conflict events.

level [level]
Specifies the severity level given by [level] to use in monitoring events for the 
specified components or ports. [level] can be one of the following values:

critical
Monitors critical events.

warn
Monitors warning events.

info
Monitors informational events. To maintain optimal switch performance, do 
not use this setting with the Component keyword set to All.

none
Monitors none of the severity levels.

port [ports]
Specifies one or more ports to monitor for events. Choose one of the following 
values:

<port number list>
Specifies port or ports to monitor. Use spaces to delimit values in the list. 
Ports are numbered beginning with 0.

all
Specifies all ports.

none
Disables monitoring on all ports.

restore
Returns the port, component, and level settings to the default values.

save
Saves the log settings for the component, level and port. These settings remain in 
effect after a switch reset. To retrieve the actual log entries, refer to the Set Log 
Archive command.



A – Command Line Interface
Set Log Command

A-32 59022-03 D

�

start
Starts the logging of events based on the Port, Component, and Level keywords 
assigned to the active configuration. The logging continues until you enter the Set 
Log Stop command.

stop
Stops logging of events.

Notes To maintain optimal switch performance, do not set the Component keyword to All 
and the Level keyword to Info at the same time.
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Set Port Command
Sets port state and speed for the specified port temporarily until the next switch 
reset or new configuration activation. This command also clears port counters.

Authority Admin

Syntax set port [port_number]
bypass
clear 
enable
speed [transmission_speed]
state [admin_state]

Keywords [port_number]
Specifies the port. Ports are numbered beginning with 0.

bypass
Sends a Loop Port Bypass (LPB) to a specific Arbitrated Loop Physical Address 
(ALPA) or to all ALPAs on the arbitrated loop.

clear
Clears the counters on the specified port.

enable
Sends a Loop Port Enable (LPE) to all ALPAs on the arbitrated loop.

speed [transmission_speed]
Specifies the transmission speed for the specified port. Choose one of the 
following port speed values:

1Gb/s
One gigabit per second.

2Gb/s
2 gigabits per second.

Auto
The port speed is automatically detected.

state [admin_state]
Specifies the administrative state for the specified port. Choose one of the 
following port state values:

online
Places the port online.

offline
Places the port offline. 

diagnostics
Prepares the port for testing.

down
Disables the port. 
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Set Setup Command
Changes SNMP and system configuration settings. The switch maintains one 
SNMP configuration and one system configuration.

Authority Admin

Syntax set setup
snmp
system

Keywords snmp
Prompts you in a line-by-line fashion to change SNMP configuration settings. 
Table A-9 describes the SNMP fields. For each parameter, enter a new value or 
press the Enter key to accept the current value shown in brackets.

Table A-9. SNMP Configuration Settings

Entry Description

Contact Specifies the name of the person to be contacted to respond 
to trap events. The default is undefined.

Location Specifies the switch location. The default is undefined.

Trap [1-5] Enabled Specifies whether traps (event information) are enabled or 
disabled (default). 

Trap [1-5] Address Specifies the IP address to which SNMP traps are sent. The 
default is 127.0.0.1.

Trap [1-5] Port Specifies the port for which SNMP traps are sent. 

Trap [1-5] Severity Specifies the severity level to use when monitoring trap 
events. The default is Warning

ReadCommunity Read Community Authentication. A write-only field; the 
value on the switch and the SNMP management server 
must be the same.

WriteCommunity Write Community Authentication. A write-only field; the 
value on the switch and the SNMP management server 
must be the same.

TrapCommunity Trap Community Authentication. A write-only field; the value 
on the switch and the SNMP management server must be 
the same. 

AuthFailureTrap Specifies the IP address where a notification is sent in the 
event of an authentication failure.
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system
Prompts you in a line-by-line fashion to change system configuration settings. 
Table A-10 describes the system configuration fields. For each parameter, enter a 
new value or press the Enter key to accept the current value shown in brackets.

Notes The two components of SANbox2 security are user authentication and fabric 
security. The user must be authenticated before gaining access to a switch. If an 
invalid account name/password combination is entered, that user can not access 
the switch, and thus can not gain access to the fabric. If security is enabled (on) 
and a valid account name/password combination is entered, that user can access 
the switch but can not execute any command that exceeds their authority 
(privileges) level. If security is disabled (off) and a valid account name/password 
combination is entered, that user has access to all switches in the fabric and can 
execute all commands (both user and admin), regardless of their authority 
(privileges) level. 

Examples The following is an example of the Set Setup SNMP command:

SANbox2 $> admin start

SANbox2 (admin) #> set setup snmp

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the default value.

  If you wish to terminate this process before reaching the end of the list

Table A-10. System Configuration Settings

Entry Description

NetworkIPAddress Internet Protocol (IP) address for the Ethernet port.

NetworkIPMask Subnet mask address for the Ethernet port.

GatewayIPAddress IP address gateway.

NetworkDiscovery Boot Method (1 - Static, 2 - Bootp, 3 - DHCP, 4 - RARP)

AdminTimeout Specifies the amount of time in minutes the switch waits 
before terminating an idle Admin session. Zero (0) disables 
the time out threshold. The default is 30, the maximum is 
1440.

Security Enabled Enables or disables the enforcement of account names and 
passwords.

Remote Log 
Enabled

Whether remote logging of is enabled or disabled. If 
enabled, log information is saved to a remote host that 
supports the syslog protocol.

LogHost IP 
Address

The IP address of the host that will receive the remote log 
information if remote logging is enabled.
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  press ’q’ or ’Q’ and the ENTER key to do so.

  Trap Severity Options

  ---------------------

  unknown, emergency, alert, critical, error, warning, notify, info, debug

  Contact             (string, max=32 chars)       [Technical Support]

  Location            (string, max=32 chars)       [TSLab            ]

  Trap1Enabled        (True / False)               [True             ]

  Trap1Address        (dot-notated IP Address)     [10.20.71.15      ]

  Trap1Port           (decimal value)              [162              ]

  Trap1Severity       (see allowed options above)  [warning          ]

  Trap2Enabled        (True / False)               [False            ]

  Trap2Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap2Port           (decimal value)              [162              ]

  Trap2Severity       (see allowed options above)  [warning          ]

  Trap3Enabled        (True / False)               [False            ]

  Trap3Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap3Port           (decimal value)              [162              ]

  Trap3Severity       (see allowed options above)  [warning          ]

  Trap4Enabled        (True / False)               [False            ]

  Trap4Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap4Port           (decimal value)              [162              ]

  Trap4Severity       (see allowed options above)  [warning          ]

  Trap5Enabled        (True / False)               [False            ]

  Trap5Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap5Port           (decimal value)              [162              ]

  Trap5Severity       (see allowed options above)  [warning          ]

  ReadCommunity       (string, max=32 chars)       [public           ]

  WriteCommunity      (string, max=32 chars)       [private          ]

  TrapCommunity       (string, max=32 chars)       [public           ]

  AuthFailureTrap     (True / False)               [False            ]

  Do you want to save and activate this snmp setup? (y/n) [ ]
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The following is an example of the Set Setup System command:

SANbox2 $> admin start

SANbox2 (admin) #> set setup system

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the default value.

  If you wish to terminate this process before reaching the end of the list

  press ’q’ or ’Q’ and the ENTER key to do so.

  NetworkIPAddress  (dot-notated IP Address)            [172.22.10.170]

  NetworkIPMask     (dot-notated IP Address)            [255.255.252.0]

  GatewayIPAddress  (dot-notated IP Address)            [172.22.8.254 ]

  NetworkDiscovery  (1=Static, 2=Bootp, 3=Dhcp, 4=Rarp) [Dhcp         ]

  AdminTimeout      (dec value 0-1440 minutes, 0=never) [30           ]

  SecurityEnable    (True / False)                      [False        ]

  RemoteLogEnable   (True / False)                      [False        ]

  LogHost IP Address (True / False)                     [False        ]
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Set Switch Command
Temporarily changes the administrative state for all ports on the switch. The 
previous Set Config Switch settings are restored after a switch reset or a 
reactivation of a switch configuration. 

Authority Admin

Syntax set switch
state [admin_state]

Keywords state [admin_state]
Specifies the administrative state as given by [admin_state]:

online
Places all ports online

offline
Places all ports offline.

diagnostics
Prepares all ports for testing.
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Show Command
Displays fabric, switch, and port operational information.

Authority User

Syntax show
about
alarm
broadcast
chassis
config [option]
domains
donor
fabric
intro
log [option]
lsdb
mem [count]
ns
perf [option]
port [port_number]
setup [option]
steering [domain_id]
switch
topology
users

Keywords about
Displays an introductory set of information about operational attributes of the 
switch. It is functionally equivalent to the Show Intro command.

alarm
Displays the last 200 alarm entries.

broadcast
Displays the broadcast tree information and all ports that are currently transmitting 
and receiving broadcast frames. 

chassis
Displays chassis component status and temperature.

config [option]
Displays switch and port configuration attributes. Refer to the Show Config 
Command on page A-48.

domains
Displays list of each domain and its worldwide name in the fabric.

donor
Displays list of current donor configuration for all ports.
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fabric
Displays list of each domain, fabric ID, worldwide name, node IP address, port IP 
address, and symbolic name in the fabric. 

intro
Displays an introductory set of information about operational attributes of the 
switch. It is functionally equivalent to the Show About command.

log [option]
Displays log entries. Refer to the Show Log Command on page A-50.

lsdb
Displays Link State database information.

mem [count]
Displays information about memory activity in 1K block units. [count] is the 
number of updates at 1 second intervals.

ns
Displays name server information.

perf [option]
Displays performance information for all ports. Refer to the Show Perf Command 
on page A-52.

port [port_number]
Displays operational information for the port given by [port_number]. Ports are 
numbered beginning with 0. If the port number is omitted, information is displayed 
for all ports. Table A-11 describes the port parameters.

Table A-11. Show Port Parameters 

Entry Description

AIinit Incremented each time the port begins AL initialization.

AIinitError Number of times the port entered initialization and the 
initialization failed.

ClassXFramesIn Number of class x frames received by this port.

ClassXFramesOut Number of class x frames sent by this port.

ClassXWordsIn Number of class x words received by this port.

ClassXWordsOut Number of class x words sent by this port.

DecodeError Decoding error detected.
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FBusy Number of times the switch sent a P_BSY because Class 2 
frame could not be delivered within ED_TOV time. Number 
of class 2 and class 3 fabric busy (F_BSY) frames generated 
by this port in response to incoming frames. This usually 
indicates a busy condition on the fabric or N_port that is 
preventing delivery of this frame.

Flowerrors Received a frame when there were no available credits.

FReject Number of frames from devices that were rejected.

InvalidCRC Invalid CRC detected.

InvalidDestAddr Invalid destination address detected.

LIP ALPD ALPS Number of F7, AL_PS LIPs, or AL_PD (vendor specific) 
resets, performed.

LIPF7ALPS This LIP is used to reinitialize the loop. An L_port, identified 
by AL_PS, may have noticed a performance degradation 
and is trying to restore the loop.

LIPF8ALPS This LIP denotes a loop failure detected by the L_port 
identified by AL_PS.

LIPF7F7 A loop initialization primitive frame used to acquire a valid 
AL_PA.

LIPF8F7 A loop initialization primitive frame used to indicate that a 
loop failure has been detected at the receiver.

Link Failures Number of optical link failures detected by this port. A link 
failure is a loss of synchronization for a period of time 
greater than the value of R_T_TOV or by loss of signal while 
not in the offline state. A loss of signal causes the switch to 
attempt to re-establish the link. If the link is not 
re-established by the time specified by R_T_TOV, a link 
failure is counted. A link reset is performed after a link 
failure.

Login Time when user logged in.

Logout Time when user logged out.

LoopTimeouts A two (2) second timeout as specified by FC-AL-2.

LossOfSync Number of synchronization losses (>100 ms) detected by 
this port. A loss of synchronization is detected by receipt of 
an invalid transmission word.

Table A-11. Show Port Parameters (Continued)

Entry Description
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setup [option]
Displays setup attributes for the system, SNMP, and the switch manufacturer. 
Refer to the Show Setup Command on page A-53.

steering [domain_id]
Displays the routes that data takes to the switch given by [domain_id]. If you omit 
[domain_id], the system displays routes for all switches in the fabric. 

switch
Displays switch operational information.

topology
Displays all connected devices.

users
Displays all user logins.

PrimSeqErrors Primitive sequence errors detected.

RxLinkResets Number of link reset primatives received from an attached 
device.

RxOfflineSeq Number of offline sequences received. An OLS is issued for 
link initialization, a Receive & Recognize Not_Operational 
(NOS) state, or to enter the offline state.

TotalErrors Total number of errors detected.

TotalLIPsRecvd Number of loop initialization primitive frames received by this 
port.

TotalLinkResets Total number of link reset primatives. 

TotalOfflineSeq Total number of Offline Sequences issued by this port. 

TotalRxFrames Total number of frames received by this port.

TotalRxWords Total number of words received by this port.

TotalTxFrames Total number of frames issued by this port.

TotalTxWords Total number of words issued by this port.

TxLinkResets Number of Link Resets issued by this port.

TxOfflineSeq Total number of Offline Sequences issued by this port. 

TxWait Time waiting to transmit when blocked with no credit. 
Measured in FC Word times

Table A-11. Show Port Parameters (Continued)

Entry Description
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Examples The following is an example of the Show Chassis command:

SANbox2 $> show chassis

  Chassis Information

  -------------------

  BoardTemp (1) - Degrees Celsius   32

  BoardTemp (2) - Degrees Celsius   36

  FanStatus (1)                     Good

  FanStatus (2)                     Good

  PowerSupplyStatus (1)             Good

  PowerSupplyStatus (2)             Good

The following is an example of the Show Domains command:

SANbox2 $> show domains

  Principal switch is (local): 10:00:00:c0:dd:00:90:6b

  Domain ID List:

        Domain 22 (0x16)        WWN = 10:00:00:c0:dd:00:90:6b                  

The following is an example of the Show Fabric command:

SANbox2 $> show fabric

Switch ID     WWN         NodeIPAddress PortIPAddress SymbolicName
------ --     ---         ------------- ------------- ------------
100     fffc64 10:00:00:60:69:20:4c:a2

103     fffc67 10:00:00:c0:dd:00:b9:09

104     fffc68 10:00:00:c0:dd:00:b8:4b 
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The following is an example of the Show Setup SNMP command:

SANbox2 $> show setup snmp

  SNMP Information

  ----------------

  Contact               Technical Support

  Location              TSLab

  Description           QLogic SANbox2 FC Switch

  Trap1Enabled          True

  Trap1Address          10.20.71.15

  Trap1Port             162

  Trap1Severity         warning

  Trap2Enabled          False

  Trap2Address          0.0.0.0

  Trap2Port             162

  Trap2Severity         warning

  Trap3Enabled          False

  Trap3Address          0.0.0.0

  Trap3Port             162

  Trap3Severity         warning

  Trap4Enabled          False

  Trap4Address          0.0.0.0

  Trap4Port             162

  Trap4Severity         warning

  Trap5Enabled          False

  Trap5Address          0.0.0.0

  Trap5Port             162

  Trap5Severity         warning

  ObjectID              1.3.6.1.4.1.1663.1.1.1.1.11

  AuthFailureTrap       False

The following is an example of the Show Topology command:

SANbox2 $> show topology

Port Local Local Remote Remote Unique

Number Type PortWWN Type NodeWWN ID

------ ----- ------- ------ ------- ------
0 E 20:00:00:c0:dd:00:b8:4b E 10:00:00:c0:dd:00:b8:4b 67

1 E 20:01:00:c0:dd:00:b8:4b E 10:00:00:c0:dd:00:b8:4b 67

11 TL 20:0b:00:c0:dd:00:b8:4b 

NL 50:80:02:00:00:06:d5:38 75
NL 20:00:00:20:37:2b:08:c9 7a

NL 20:00:00:20:37:2b:01:2c 7c
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NL 20:00:00:20:37:2b:05:c9 80

NL 20:00:00:20:37:2b:09:5e 81

NL 20:00:00:20:37:2b:09:20 82

13 TL 20:0d:00:c0:dd:00:b8:4b NL 50:80:02:00:00:06:d5:38 75

NL 20:00:00:20:37:2b:08:c9 7a

NL 20:00:00:20:37:2b:01:2c 7c

NL 20:00:00:20:37:2b:05:c9 80

NL 20:00:00:20:37:2b:09:5e 81

NL 20:00:00:20:37:2b:09:20 82
NL 20:00:00:20:37:2b:07:d8 84

NL 20:00:00:20:37:2b:0a:98 88

NL 20:00:00:20:37:2b:0a:90 8f

NL 20:00:00:20:37:2b:05:22 90

NL 20:00:00:20:37:2b:09:ca 97

NL 20:00:00:20:37:2b:07:bd 98

15 FL 20:0f:00:c0:dd:00:b8:4b NL 20:00:00:20:37:d9:48:81 1f

NL 20:00:00:20:37:d9:4a:76 23

NL 20:00:00:20:37:d9:4b:33 25

NL 20:00:00:20:37:d9:4b:61 8f 

The following is an example of the Show Topology (for Port #11) command:

SANbox2 #> show topology 11

Local Link Information

---------------------- 

PortNumber 11

PortID 680b00

PortWWN 20:0b:00:c0:dd:00:b8:4b

PortType TL 

Remote Link Information

----------------------- 

Device 0 

NodeWWN 50:80:02:00:00:06:d5:38

PortType NL

Description (NULL)

IPAddress 0.0.0.0 

Device 1 

NodeWWN 20:00:00:20:37:2b:08:c9

PortType NL

Description (NULL)

IPAddress 0.0.0.0 

Device 2 
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Description (NULL)

IPAddress 0.0.0.0

Device 3

NodeWWN 20:00:00:20:37:2b:05:c9

PortType NL

Description (NULL)

IPAddress 0.0.0.0

The following is an example of the Show Port command:

SANbox2 $> show port 3

  Port Number: 3

  --------------

  AdminState       Online              OperationalState Offline

  AsicNumber       1                   PortID           050300

  AsicPort         3                   PortWWN          20:03:00:c0:dd:00:90:6b

  ConfigType       GL                  RunningType      Unknown

  DiagStatus       Passed              SFPPartNumber    Unknown

  EpConnState      None                SFPRevision      0

  EpIsoReason      NotApplicable       SFPType          NotInstalled

  LinkSpeed        Auto                SFPVendor        Unknown

  LinkState        Inactive            SFPVendorID      0

  LoginStatus      NotLoggedIn         SymbolicName     Port3

  MaxCredit        12                  SyncStatus       SyncLost

  ALInit          1         FReject         0         RxLinkResets    0

  ALInitError     0         InvalidCRC      0         RxOfflineSeq    0

  Class2FramesIn  0         InvalidDestAddr 0         TotalErrors     0

  Class2FramesOut 0         LIP_AL_PD_AL_PS 0         TotalLIPsRecvd  0

  Class2WordsIn   0         LIP_F7_AL_PS    0         TotalLinkResets 0

  Class2WordsOut  0         LIP_F7_F7       0         TotalOfflineSeq 2

  Class3FramesIn  0         LIP_F8_AL_PS    0         TotalRxFrames   0

  Class3FramesOut 0         LIP_F8_F7       0         TotalRxWords    0

  Class3Toss      0         LinkFailures    0         TotalTxFrames   0

  Class3WordsIn   0         Login           0         TotalTxWords    0

  Class3WordsOut  0         Logout          0         TxLinkResets    0

  DecodeError     0         LoopTimeouts    0         TxOfflineSeq    2

  FBusy           0         LossOfSync      0         TxWait          0

  FlowErrors      0         PrimSeqErrors   0
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  The following is an example of the Show Switch command:

  SANbox2 $> show switch

  Switch Information

  ------------------

  SymbolicName                      SANbox2-203

  SwitchWWN                         10:00:00:c0:dd:00:b8:b5

  SwitchType                        SANbox2-16

  PromVersion                       V0.1-5-18  (Fri Jun 15 10:22:09 2001)

  CreditPool                        0

  DomainID                          3

  LogLevel                          Info

  MaxPorts                          16

  NumberOfAsics                     1

  NumberOfPortsPerAsic              16

  NumberOfResets                    127

  ReasonForLastReset                NormalReset

  SWImageVersion (1) - build date   V0.4-6-16  (Thu Jun 14 04:06:42 2001)

  SWImageVersion (2) - build date   V0.4-6-18  (Fri Jun 15 10:22:09 2001)

  ActiveConfiguration               default

  ActiveSWImage                     2

  AdminState                        Online

  AdminModeActive                   False

  BeaconOnStatus                    False

  OperationalState                  Online

  PrincipalSwitchRole               False

  BoardTemp (1) - Degrees Celsius   32

  BoardTemp (2) - Degrees Celsius   36

  SwitchDiagnosticsStatus           Passed

  SwitchTemperatureStatus           Normal
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Show Config Command
Display switch and port attributes for the active configuration.

Authority User

Syntax show config
port [port_number]
switch
zoning

Keywords port [port_number]
Displays configuration parameters for the port number given by [port_number]. 
Ports are numbered beginning with 0. If the port value is omitted, all ports are 
specified.

switch
Displays configuration parameters for the switch.

zoning
Displays zoning configuration parameters for the switch.

Examples The following is an example of the Show Config Port command:

SANbox2 $> show config port 3

  Configuration Name: default

  -------------------

  Port Number: 3

  ------------

  AdminState       Online

  LinkSpeed        Auto

  PortType         GL

  TLPortMode       TLInitiatorMode

  ISLSecurity      Any

  SymbolicName     Port4

  ALFairness       False

  ARB_FF           False

  InteropCredit    0

  FanEnable        True

  ExtCredit        0

  FanEnable        False

  LCFEnable        False

  MFSEnable        False

  MFS_TOV          640

  MSEnable         False

  NoClose          False

  IOStreamGuard    False

  VIEnable         False

  CheckAlps        False



A – Command Line Interface
Show Config Command

59022-03 D A-49

�

The following is an example of the Show Config Switch command:

SANbox2 $> show config switch

  Configuration Name: default

  -------------------

  Switch Configuration Information

  --------------------------------

  AdminState            Online

  BroadcastEnable       False

  DomainID              11

  DomainIDLock          True

  SymbolicName          bottom switch

  R_T_TOV               100

  R_A_TOV               10000

  E_D_TOV               2000

  FS_TOV                5000

  DS_TOV                5000

  PrincipalPriority     254

  Description   

The following is an example of the Show Config Zoning command:

SANbox2 $> show config zoning

 Configuration Name: default

  -------------------

  Zoning Configuration Information

  --------------------------------

  AutoSave              True

  Default               All

  Merge Mode            SW2
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Show Log Command
Displays the contents of the log or the parameters used to create entries in the 
log. The log contains a maximum of 200 entries. When the log reaches its entry 
capacity, subsequent entries overwrite the existing entries, beginning with the 
oldest.

Authority User

Syntax show log
component
level
options
port
settings

Keywords component
Displays the components currently being monitored for events.

level
Displays the event severity level needed to create an entry in the log. If the 
severity level occurs on a port or on a component which is not defined, no entry is 
made in the log.

options
Displays the options used to set the component and log level attributes.

port
Displays the ports being monitored for events. If an event occurs which is of the 
defined level and on a defined component, but not on a defined port, no entry is 
made in the log.

settings
Displays the current settings for component, level and port. This command is 
equivalent to executing the following commands separately: Show Log 
Component, Show Log Level, and Show Log Port.

Examples The following is an example of the Show Log Component command:

SANbox2 $> show log component

  Current setting(s) for log component: NameServer

The following is an example of the Show Log Level command:

SANbox2 $> show log level

  Current setting(s) for log level: Info
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The following is an example of the Show Log Options command:

SANbox2 $> show log options

  Allowed options for ’    level’: Critical,Warn,Info,None

  Allowed options for ’component’: All,None,NameServer,MgmtServer,Zoning,Switch,

Chassis,Blade,Port,Eport,Snmp,Other

The following is an example of the Show Log command:

[327][Wed Jan 25 09:36:54.860 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Eport

 State = E_A0_GET_DOMAIN_ID]

   [328][Wed Jan 25 09:36:54.860 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][FSPF

 PortUp state=0]

   [329][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send

ing init hello]

   [330][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Proc

essing EFP, oxid= 0x8]

   [331][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Epor

t State = E_A2_IDLE]

   [332][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][EFP,

 WWN= 0x100000c0dd00b845, len= 0x30]

   [333][Wed Jan 25 09:36:54.864 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send

ing LSU oxid= 0xc: type= 1]

   [334][Wed Jan 25 09:36:54.864 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send

 Zone Merge Request]

   [335][Wed Jan 25 09:36:54.865 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][LSDB

 Xchg timer set]

   [336][Wed Jan 25 09:36:54.865 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Sett

ing attribute Oper.UserPort.0.8.EpConnState Connected]
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Show Perf Command
Displays performance data for all ports.

Authority User

Syntax show perf
byte [bytes/sec]
frame [frames/sec]

Keywords byte [bytes/sec]
Displays port performance data for all ports in bytes/second. The display is 
refreshed according to the interval in seconds given by [bytes/sec]. If [bytes/sec] 
is omitted, the display is refreshed every second. Type “q” and press the Enter key 
to stop the display.

frame [frames/sec]
Displays port performance data for all ports in frames/second. The display is 
refreshed according to the interval in seconds given by [frames/sec]. If 
[frames/sec] is omitted, the display is refreshed every second. Type “q” and press 
the Enter key to stop the display.

Notes The Show Perf command with no keywords displays performance data in 
frames/second and bytes/second at that moment.

Examples The following is an example of the Show Perf Byte command:

SANbox2 $> show perf byte

  Displaying bytes/sec data...  (Press ’q’ and the ENTER key to stop display)

  0    1    2    3    4    5    6    7    8    9    10   11   12   13   14   15

  -----------------------------------------------------------------------------

  0    0    0    0    0    0    0    0    0    0    0    0    0    0    0    0

  0    0    0    0    0    0    0    0    0    0    0    0    0    0    0    0

  0    0    0    0    0    0    0    0    0    0    0    0    0    0    0    0 
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Show Setup Command
Displays the current SNMP and system settings.

Authority User

Syntax show setup
snmp
system

Keywords snmp
Displays the current SNMP settings.

system
Displays the current system settings.

Examples The following is an example of the Show Setup Snmp command:

SANbox2 $> show setup snmp

  SNMP Information

  ----------------

  Contact               <sysContact undefined>

  Location              <sysLocation undefined>

  Description           QLogic SANBox2 FC Switch

  Trap1Enabled          False

  Trap1Address          10.0.0.254

  Trap1Port             162

  Trap1Severity         warning

  Trap2Enabled          False

  Trap2Address          0.0.0.0

  Trap2Port             162

  Trap2Severity         warning

  Trap3Enabled          False

  Trap3Address          0.0.0.0

  Trap3Port             162

  Trap3Severity         warning

  Trap4Enabled          False

  Trap4Address          0.0.0.0

  Trap4Port             162

  Trap4Severity         warning

  Trap5Enabled          False

  Trap5Address          0.0.0.0

  Trap5Port             162

  Trap5Severity         warning

  ObjectID              1.3.6.1.4.1.1663.1.1.1.1.11

  AuthFailureTrap       False
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The following is an example of the Show Setup System command:

SANbox2 $> show setup system

  System Information

  ------------------

  NetworkIPAddress     172.22.11.202

  NetworkIPMask        255.255.252.0

  GatewayIPAddress     172.22.8.254

  NetworkDiscovery     Static

  AdminTimeout         30

  SecurityEnable       False

  RemoteLogEnable      False

  LogHostIPAddress     undefined
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Shutdown Command
Terminates all data transfers on the switch at convenient points and closes the 
Telnet session. 

Authority Admin

Syntax shutdown
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Test Command
Performs the port loopback test to verify the operation of a port. The three types of 
loopback tests are Internal (SerDes level), External (SFP), and Online. While the 
test is running, the remaining ports on the switch remain fully operational. 

Authority Admin

Syntax test [port_number] [test_type]

Keywords [port_number]
Specifies the port. Ports are numbered beginning with 0.

[test_type]
The test type. If you omit [test_type], the internal loopback test is run. [test_type] 
can be one of the following values:

cancel
Cancels online test in progress.

internal 
Tests the SerDes.

external
Tests both the SerDes and SFP. Requires a loopback plug be installed in the 
SFP.

online
Tests one online port.

status
Displays the status of a test in progress, or if there is no test in progress, the 
status of the test that was executed last.

Examples To run Internal (SerDes) or External (SFP) port tests, do the following:

1. To start an Admin session, enter the following command and press the Enter 
key.

admin start

2. Place the port in Diagnostics mode, enter the following command (x = port 
number) and press the Enter key. 

set port x state diagnostics

3. Insert the loopback plug into the SFP on the selected port.

4. Choose one of the two types of Port Loopback Tests to run:

■ To run an internal loopback test, enter the following and press the 
Enter key:

test x internal

■ To run an external loopback test, enter the following command. A 
loopback plug must be installed for this test to pass. 

test x external
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5. After the test type has been chosen and the command executed, a message 
on the screen will appear detailing the test results.

6. After the test is run, put the port back into online state by entering the 
following command (x = port number) and pressing the Enter key. 

set port x state online

7. To verify port is back online, enter the following command and press the 
Enter key. The contents of the AdminState field should display be “Online”.

show port x

The online loopback (node-to-node) test can test only one port at a time, and that 
port must be online and connected to a remote device. To run the online loopback 
test, do the following:

1. To start an Admin session, enter the following command and press the Enter 
key.

admin start

2. To run the online loopback test, enter the following command and press the 
Enter key. 

test x online

3. A series of test parameters are displayed on the screen. Press the Enter key 
to accept each default parameter value, or type a new value for each 
parameter and press the Enter key. The TestLength parameter is the 
number of frames sent, the FrameSize (256 byte maximum in some cases) 
parameter is the number of bytes in each frame, and the DataPattern 
parameter is the pattern in the payload. Before running the test, make sure 
that the device attached to the port can handle the test parameters.

SANbox2N107 (admin) #> test x online

A list of attributes with formatting and current values will 
follow. Enter a new value or simply press the ENTER key to 
accept the default value. If you wish to terminate this 
process before reaching the end of the list press ’q’ or ’Q’ 
and the ENTER key to do so.

  TestLength    (decimal value, 1-4294967295)   [100    ]

  FrameSize     (decimal value, 36-2148)        [256    ]

  DataPattern   (32-bit hex value or ’Default’) [Default]

  StopOnError   (True/False)                    [False  ]

  Do you want to start the test? (y/n) [n]

4. After all parameter values are defined, press the Y key to start the test. 
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Uptime Command
Displays the elapsed time since the switch was last reset and reset method.

Authority User

Syntax uptime

Examples The following is an example of the Uptime command:

SANbox2 $> uptime

  Elapsed up time  : 0 day(s), 2 hour(s), 28 min(s), 44 sec(s)

  Reason last reset: NormalReset
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User Command
Administers or displays user accounts. 

Authority Admin

Syntax user
accounts
add
delete [account_name]
list

Keywords accounts
Displays all user accounts that exist on the switch.

add
Add a user account to the switch. After this command is executed, the 
administrator will be prompted for the information needed to establish the user 
account.

delete [account_name]
Deletes the account name given by [account_name] from the switch.

list
Displays the list of users currently logged in and their session numbers. Provides 
the same function as the Show User command. This keyword is valid for User 
authority and does not require an admin session.

Examples The following is an example of the User Accounts command:

SANbox2 (admin) #> user accounts

  Current list of user accounts

  -----------------------------

  admin        (admin authority = True)

  user1        (admin authority = False)

  user2        (admin authority = False)

  user3        (admin authority = True)

The following is an example of the User Add command:

SANbox2 (admin) #> user add

      Press ’q’ and the ENTER key to abort this command.

  account name (1-15 chars)      : user3

  account password (4-20 chars)  :

  please confirm account password:
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  should this account have admin authority? (y/n) [n] : y

  OK to add user account ’user3’ with admin authority?

  Please confirm (y/n): [n] y

The following is an example of the User Delete command:

SANbox2 (admin) #> user del user3

  The user account will be deleted.  Please confirm (y/n): [n] y

The following is an example of the User List command:

SANbox2 (admin) #> user list

  Current list of users logged in

  -------------------------------

  admin@OB-session1 - in admin mode

  admin@OB-session2

  user1@OB-session3

SANbox2 (admin) #>
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Whoami Command
Displays the account name, session number, and switch domain ID for the Telnet 
session.

Authority User

Syntax whoami

Examples The following is an example of the Whoami command:

SANbox2 $> whoami

User name:admin@session2

Switch name:SANbox2

Switch domain ID:1
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Zone Command
Manages zones and zone membership on a switch. The Zone command defines 
members (ports and devices) for a single switch. Zones are members of zone 
sets.

Authority Admin authority within a Zoning Edit session. Refer to the Zoning Command on 
page A-67. List, Members, and zone sets keywords are available with User 
authority and do not require a Zoning Edit session.

Syntax zone
add [zone] [members]
copy [zone_source] [zone_destination]
create [zone]
delete [zone]
list
members [zone]
remove [zone] [members]
rename [zone_old [zone_new]
type [zone] [zone_type]
zonesets [zone]

Keywords add [zone] [members]
Specifies one or more ports given by [members] to add to the zone named [zone]. 
The application verifies that the [zone] format is correct, but does not validate that 
such a port exists. [members] can have one of the following formats:

■ Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.

■ 6-character device Fibre Channel address (hex)

■ 16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.

■ Alias name

copy [zone_source] [zone_destination]
Creates a new zone named [zone_destination] and copies the membership into it 
from the zone given by [zone_source].

create [zone]
Creates a zone with the name given by [zone]. The zone name can have a 
maximum of 64 alpha-numeric characters without spaces.

delete [zone]
Deletes the specified zone given by [zone] from the zoning database. If the zone 
is a member of the active zone set, the zone will not be removed from the active 
zone set until the active zone set is deactivated.

list
Displays a list of all zones and the zone sets of which they are members. This 
keyword is valid for User authority and does not require a zoning edit session.



A – Command Line Interface
Zone Command

59022-03 D A-63

�

members [zone]
Displays all members of the zone given by [zone]. This keyword is available with 
User authority and does not require a Zoning Edit session.

remove [zone] [members]
Removes the ports given by [members] from the zone given by [zone]. The 
[members] can have one of the following formats:

■ Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.

■ 6-character device Fibre Channel address (hex)

■ 16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.

■ Alias name

rename [zone_old] [zone_new]
Renames the zone given by [zone_old] to the zone given by [zone_new].

type [zone] [zone_type]
Specifies the zone type given by [zone_type] to be assigned to the zone name 
given by [zone]. If you omit the [zone_type], the system displays the zone type for 
the zone given by [zone]. [zone_type] can be one of the following:

soft
Name server zone

hardacl
Access control list hard zone

hardvpf
Virtual private fabric hard zone

zonesets [zone]
Displays all zone sets of which the zone given by [zone] is a member. This 
keyword is available with User authority and does not require a Zoning Edit 
session.

Examples The following is an example of the Zone List command:

SANbox2 $> zone list

 

  Zone        ZoneSet

  -------------------

  wwn_b0241f

              zone_set_1

 

  wwn_23bd31

              zone_set_1

 

  wwn_221416
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              zone_set_1

 

  wwn_2215c3

              zone_set_1

 

  wwn_0160ed

              zone_set_1

 

  wwn_c001b0

              zone_set_1

 

  wwn_401248

              zone_set_1

 

  wwn_02402f

              zone_set_1

 

  wwn_22412f

              zone_set_1

The following is an example of the Zone Members command:

SANbox2 $> zone members wwn_b0241f

  Current List of Members for Zone: wwn_b0241f

  ---------------------------------

  50:06:04:82:bf:d2:18:c2

  50:06:04:82:bf:d2:18:d2

  21:00:00:e0:8b:02:41:2f

The following is an example of the Zone Zonesets command:

SANbox2 $> zone zonesets zone1

  Current List of ZoneSets for Zone: wwn_b0241f

  ----------------------------------

  zone_set_1 
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Zoneset Command
Manages zone sets and zone set membership across the fabric.

Authority Admin authority within a Zoning Edit session. Refer to the Zoning Command on 
page A-67. Active, List, Zones keywords are available with User authority. You 
must close the Zoning Edit session before using the Activate and Deactivate 
keywords.

Syntax zoneset
active
activate [zone_set]
add [zone_set] [zone_list or alias]
copy [zone_set_source] [zone_set_destination]
create [zone_set]
deactivate
delete [zone_set]
list
remove [zone_set] [zone_list or alias]
rename [zone_set_old] [zone_set_new]
zones [zone_set]

Keywords active
Displays the name of the active zone set. This keyword is available with User 
authority and does not require a Zoning Edit session.

activate [zone_set]
Activates the zone set given by [zone_set]. This keyword deactivates the active 
zone set. Close the Zoning Edit session before using this keyword.

add [zone_set] [zone_list or alias]
Adds one or more zones given by [zone_list] to the zone set given by [zone]. 
[zone_list] can be an alias. This keyword requires a Zoning Edit session.

copy [zone_set_source] [zone_set_destination]
Creates a new zone set named [zone_set_destination] and copies into it the 
membership from the zone set given by [zone_set_source]. This keyword requires 
a Zoning Edit session.

create [zone_set]
Creates the zone set with the name given by [zone_set]. A zone set name can 
have a maximum of 64 alpha-numeric characters without spaces. This keyword 
requires a Zoning Edit session.

deactivate
Deactivates the active zone set. Close the Zoning Edit session before using this 
keyword.

delete [zone_set]
Deletes the zone set given by [zone_set]. If the specified zone set is active, the 
command is suspended until the zone set is deactivated. This keyword requires a 
Zoning Edit session.
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list
Displays a list of all zone sets. This keyword is available with User authority and 
does not require a Zoning Edit session.

remove [zone_set] [zone_list]
Removes one or more zones given by [zone_list] from the zone set given by 
[zone_set]. If [zone_set] is the active zone set, the zone will not removed until the 
zone set has been deactivated. [zone_list] can be an alias. This keyword requires 
a Zoning Edit session.

rename [zone_set_old] [zone_set_new]
Renames the zone set given by [zone_set_old] to the name given by 
[zone_set_new]. You can rename the active zone set. This keyword requires a 
Zoning Edit session.

zones [zone_set]
Displays all zones that are members of the zone set given by [zone_set]. This 
keyword is available with User authority and does not need a Zoning Edit session.

Notes ■ A zone set must be active for its definitions to be applied to the fabric.

■ Only one zone set can be active at one time.

■ A zone can be a member of more than one zone set.

Examples The following is an example of the Zoneset Active command:

SANbox2 $> zoneset active

  The active ZoneSet is:  Beta

The following is an example of the Zoneset List command:

SANbox2 $> zoneset list

  Current List of ZoneSets

  ------------------------

  alpha

  beta

The following is an example of the Zoneset Zones command:

SANbox2 $> zoneset zones ssss

  Current List of Zones for ZoneSet: ssss

  ----------------------------------

  zone1

  zone2

  zone3
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Zoning Command
Opens a Zoning Edit session in which to create and manage zone sets and zones. 
Refer to the Zone Command on page A-62 and the Zoneset Command on 
page A-65.

Authority Admin. The List keyword is available with User authority.

Syntax zoning
cancel
clear
edit
list
restore
save

Keywords cancel
Closes the current Zoning Edit session. Any unsaved changes are lost.

clear
Clears all zoning definitions in the volatile edit copy of the zoning database. This 
keyword does not affect the non-volatile zoning database. However, if you enter 
the Zoning Clear command followed by the Zoning Save command, the 
non-volatile zoning database will be cleared from the switch. The preferred 
method for clearing the zoning database from the switch is the Reset Zoning 
command.

edit
Opens a Zoning Edit session.

list
Lists all fabric zoning definitions. This keyword is available with User authority.

restore
Reverts the changes applied to the zoning database with the Zoning Save 
command.

save
Saves changes made during the current Zoning Edit session. The system will 
inform you that the zone set must be activated to implement any changes. This 
does not apply if you entered the Zoning Clear command during the Zoning Edit 
session.
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Examples The following is an example of the Zoning Edit command:

SANbox2 $> admin start

SANbox2 (admin) #> zoning edit

SANbox2 (admin-zoning) #>

.

.

SANbox2 (admin-zoning) #> zoning cancel

  Zoning edit mode will be canceled.  Please confirm (y/n): [n]   y

SANbox2 (admin) #> admin end

The following is an example of the Zoning List command:

SANbox2 $> zoning list

 

  Active ZoneSet Information

 

  ZoneSet     Zone      ZoneMember

  --------------------------------

  wwn

              wwn_b0241f

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        21:00:00:e0:8b:02:41:2f

 

              wwn_23bd31

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:23:bd:31

 

              wwn_221416

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:14:16

 

              wwn_2215c3

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:15:c3 
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  Configured Zoning Information

 

  ZoneSet     Zone      ZoneMember

  --------------------------------

  wwn

              wwn_b0241f

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        21:00:00:e0:8b:02:41:2f

 

              wwn_23bd31

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:23:bd:31

 

              wwn_221416

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:14:16

 

              wwn_2215c3

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:15:c3
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Notes
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Activity LED
A port LED that indicates when frames are 
entering or leaving the port.

Alias
A collection of objects that can be zoned 
together. An alias is not a zone, and can 
not have a zone or another alias as a 
member.

AL_PA
Arbitrated Loop Physical Address

Arbitrated Loop
A Fibre Channel topology where ports use 
arbitration to establish a point-to-point 
circuit.

Arbitrated Loop Physical Address (AL_PA)
A unique one-byte valid value assigned 
during loop initialization to each NL_Port 
on a Loop.

ASIC
Application Specific Integrated Circuit

BootP
A type of network server.

Buffer Credit
A measure of port buffer capacity equal to 
one frame.

Class 2 Service
A service which multiplexes frames at 
frame boundaries to or from one or more 
N_Ports wit h acknowledgment provided.

Class 3 Service
A service which multiplexes frames at 
frame boundaries to or from one or more 
N_Ports without acknowledgment.

Domain ID
User defined name that identifies the 
switch in the fabric.

E_Port
Expansion port. A switch port that 
connects to another FC-SW-2 compliant 
switch.

Expansion Port
See E_Port.

Fabric Management Switch
The switch through which the fabric is 
managed.

Fabric Name
User defined name associated with the file 
that contains user list data for the fabric.

Fan Fail LED
An LED that indicates that a cooling fan in 
the switch is operating below standard.

FC-PLDA
Fibre Channel Private Loop Direct Attach

Flash Memory
Memory on the switch that contains the 
chassis control firmware.
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Frame
Data unit consisting of a start-of-frame 
(SOF) delimiter, header, data payload, 
CRC, and an end-of-frame (EOF) 
delimiter.

FRU
Field Replaceable Unit

Heartbeat LED
A chassis LED that indicates the status of 
the internal switch processor and the 
results of the Power-On Self-Test.

Initiator
The device that initiates a data exchange 
with a target device.

In-Order-Delivery
A feature that requires that frames be 
received in the same order in which they 
were sent.

Input Power LED
A chassis LED that indicates that the 
switch logic circuitry is receiving proper DC 
voltages.

IP
Internet Protocol

LIP
Loop Initialization Primitive sequence

Logged-In LED
A port LED that indicates device login or 
loop initialization status.

Management Information Base
A set of guidelines and definitions for the 
Fibre Channel functions.

Management Workstation
PC workstation that manages the fabric 
through the fabric management switch.

MIB
Management Information Base

NL_Port
Node Loop Port. A Fibre Channel device 
port that supports arbitrated loop protocol.

N_Port
Node Port. A Fibre Channel device port in 
a point-to-point or fabric connection.

Output Power LED
A power supply LED that indicates that the 
power supply is providing DC voltage to 
the switch.

Over Temperature LED
A chassis LED or a power supply LED that 
indicates that the switch or power supply is 
overheating.

POST
Power On Self Test

Power On Self Test (POST)
Diagnostics that the switch chassis 
performs at start up.

Private Device
A device that can communicate only with 
other devices on the same loop.

Private Loop
A loop of private devices connected to a 
single switch port.

SANbox Manager
Switch management application.
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SFF
Small Form-Factor transceiver.

SFP
Small Form-Factor Pluggable. A 
transceiver device, smaller than a GigaBit 
Interface Converter, that plugs into the 
Fibre Channel port.

Small Form Factor
A transceiver device, smaller than a 
GigaBit Interface Converter, that is 
permanently attached to the circuit board.

Small Form-Factor Pluggable
A transceiver device, smaller than a 
GigaBit Interface Converter, that plugs into 
the Fibre Channel port.

SNMP
Simple Network Management Protocol

Target
A storage device that responds to an 
initiator device.

VCCI
Voluntary Control Council for Interference

Worldwide Name (WWN)
A unique 64-bit address assigned to a 
device by the device manufacturer.

WWN
Worldwide Name

Zone
A set of ports or devices grouped together 
to control the exchange of information.

Zone Set
A set of zones grouped together. The 
active zone set defines the zoning for a 
fabric.
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Access Control List zone 3-11
account name A-61
active zone set 3-8
Active Zoneset data window 3-8, 4-6
Admin authority A-3
Admin command A-4
alarm log 4-6
alias

add member port A-5
copy A-5
create A-5
creating an alias 3-25
definition 3-11
delete A-5
delete member port A-6
managing aliases 3-25
removing an alias from all zones 3-26
rename A-6

Alias command A-5

B

boot method 4-12
BootP 4-12

C

chassis LEDs 4-3
chassis name 4-8
command format A-2
Command Line Interface A-1
Config command A-7
configuration

activate A-7
edit A-7
reset A-7, A-18
save A-8

Configured Zonesets data window 4-6
credits 5-11

D

data window
Active Zoneset 3-8
Configured Zonesets 4-6
description 2-15, 2-18, 2-20
Name Server 4-3, 5-8
Port Statistics 5-4
tabs 2-15

database
fabric 3-2
zoning 3-17

Date command A-9
default configuration 4-17
domain ID 4-9

conflict 3-10
donor port 5-11

E

E_Port 5-10
isolation 3-16

Error Detect Timeout 4-10
expansion port 5-2

F

F_Port 5-10
fabric

add 3-2
database 3-2
delete 3-3
displaying information 3-5
loop port 5-10
merge 3-16
port 5-10
status 3-6
tree 2-14
zoning 3-9

Faceplate display 2-11, 2-17, 2-18
factory default settings 4-17, A-18
Fallback command A-10
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Fan Fail LED 4-2
Fibre Channel address 3-23
firmware A-10, A-13
FL_Port 5-10

G

gateway address 4-12
generic

loop port 5-10
port 5-10

graphic window 2-15

H

hardware status 4-2
Heartbeat LED 4-2
Help command A-11
History command A-12

I

Image command A-13
Input Power LED 4-2
IP

address 4-12
configuration 4-12

L

link
delete 3-5
selecting 2-17
status 2-16

Lip command A-14
log file A-30, A-50
loop port

fabric 5-10
generic 5-2, 5-10
translated 5-10

M

management workstation 2-1
media status 5-4
menu structure 2-12

N

name server 4-7
exporting 4-7

Name Server data window 4-3, 5-8
name server zone 3-10

O

operating systems 2-1
Over Temperature LED 4-2

P

Passwd command A-15
password 3-2, A-1
popup menus 2-20
port

buffer credits 5-11
configuration 5-8, A-24
counters A-33
displaying information 5-1
donor 5-11
extending credits 5-11
initialize A-18
mode 5-2, 5-10
number 3-23
performance A-52
recipient 5-11
selecting 2-19
speed A-33
state A-33
status 2-19, 5-2
views 2-19

Port Statistics data window 5-4
port/device tree 3-17
Ps command A-16

Q

Quit command A-17

R

RARP 4-12
read community 4-13
receive buffer 5-11
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Receiver Transmitter Timeout 4-10
recipient port 5-11
refresh 3-6, 4-2
Reset command A-18
Resource Allocation Timeout 4-10

S

SANbox Manager 2-1
install 2-1
starting 2-5
user interface 2-11

SANbox2 switch 3-6
Set Alarm Clear command A-22
Set Beacon command A-23
Set Config command A-24
Set Log command A-30
Set Port command A-33
Set Setup command A-34
Set Switch command A-38
shortcut keys 2-12
Show command A-39
Show Config command A-48
Show Log command A-50
Show Perf command A-52
Show Setup command A-53
Shutdown command A-55
SNMP configuration 4-13, A-18, A-34, A-53
soft zone 3-10
subnet mask address 4-12
switch

administrative state 4-8, A-38
configuration 4-7, A-26, A-48
delete 3-5
displaying information 4-1
icons 3-6
initialize A-18
reset 4-7, A-58
restore factory defaults 4-17
selecting 2-17
status 2-16

Switch data window 4-4
system

configuration A-35

settings A-53

T

Test command A-56
timeout values 4-10
TL_Port 5-10
tool bar

standard 2-13
zoning 3-18

Topology display 2-11, 2-16
transceiver status 5-4
translated loop port 5-10
traps 4-13

U

Uptime command A-58
User authority A-3
User command A-59

V

Virtual Private Fabric zone 3-11

W

Whoami command A-61
working status indicator 2-15
worldwide name 3-23
write community 4-13

Z

zone
Access Control List 3-11
add member port 3-23, A-62
copy 3-21, A-62
create 3-22, A-62
delete A-62
delete member port 3-24, A-63
name server 3-10
remove 3-21
rename A-63
type A-63
Virtual Private Fabric 3-11

Zone command A-62
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zone merge
description 3-16
failure 3-16
failure recovery 3-16

zone set
activate 3-20, A-65
active 3-8
add member zone A-65
copy A-65
create 3-20, A-65
deactivate 3-20, A-65
delete A-65
delete all 3-22
delete member zone 3-21, A-66
display A-66
display active A-65
display members A-66
display zones A-63
rename A-66
tree 3-17

Zoneset command A-65
zoning

configuration reset A-18
database 3-17
edit A-67
list definitions A-67
save edits A-67

Zoning command A-67


	Table of Contents
	Figures
	Tables

	Section�1 Introduction
	1.1 Intended Audience
	1.2 Related Materials
	1.3 Technical Support
	1.3.1 Availability
	1.3.2 Training
	1.3.3 Contact Information


	Section�2 Using SANbox Manager
	2.1 Installing SANbox Manager
	2.1.1 For Windows:
	2.1.2 For Linux:
	2.1.3 For Solaris:

	2.2 Starting SANbox Manager
	2.3 Exiting SANbox Manager
	2.4 Uninstalling SANbox Manager
	2.5 Changing Default File Password
	2.6 Setting Preferences
	2.7 Using Online Help
	2.8 Viewing Software Version and Copyright Information
	2.9 SANbox Manager User Interface
	2.9.1 Menu Bar
	2.9.2 Tool Bar
	2.9.3 Fabric Tree
	2.9.4 Graphic Window
	2.9.5 Data Window and Tabs
	2.9.6 Working Status Indicator

	2.10 Using the Topology Display
	2.10.1 Switch and Link Status
	2.10.2 Working with Switches and Links
	2.10.2.1 Selecting Switches and Links
	2.10.2.2 Moving a Switch in the Display
	2.10.2.3 Opening the Faceplate Display and Popup Menus

	2.10.3 Topology Data Windows

	2.11 Using the Faceplate Display
	2.11.1 Port Views and Status
	2.11.2 Working with Ports
	2.11.2.1 Selecting Ports
	2.11.2.2 Opening Popup Menus

	2.11.3 Faceplate Data Windows


	Section�3 Managing Fabrics
	3.1 Security
	3.1.1 User Authentication
	3.1.2 Fabric Security

	3.2 Managing the Fabric Database
	3.2.1 Adding a Fabric
	3.2.2 Removing a Fabric
	3.2.3 Opening a Fabric View File
	3.2.4 Saving a Fabric View File
	3.2.5 Rediscovering a Fabric
	3.2.6 Adding a New Switch to a Fabric
	3.2.7 Replacing a Failed Switch in a Fabric
	3.2.8 Deleting Switches and Links

	3.3 Displaying Fabric Information
	3.3.1 Fabric Status
	3.3.2 Active Zone Set Data Window

	3.4 Zoning a Fabric
	3.4.1 Zoning Concepts
	3.4.1.1 Zones
	3.4.1.2 Aliases
	3.4.1.3 Zone Sets
	3.4.1.4 Zoning Database
	3.4.1.5 Zoning Configuration

	3.4.2 Using the Zoning Config Window
	3.4.3 Restoring Default Zoning
	3.4.4 Merging Fabrics and Zoning
	3.4.4.1 Zone Merge Failure
	3.4.4.2 Zone Merge Failure Recovery

	3.4.5 Using the Edit Zoning Window
	3.4.6 Managing Zone Sets
	3.4.6.1 Creating a Zone Set
	3.4.6.2 Activating and Deactivating a Zone Set
	3.4.6.3 Copying a Zone to a Zone Set
	3.4.6.4 Removing a Zone from a Zone Set or from All Zone Sets
	3.4.6.5 Removing a Zone Set
	3.4.6.6 Removing All Zoning Definitions

	3.4.7 Managing Zones
	3.4.7.1 Creating a Zone in a Zone Set
	3.4.7.2 Adding Zone Members
	3.4.7.3 Renaming a Zone or a Zone Set
	3.4.7.4 Removing a Zone Member
	3.4.7.5 Removing a Zone from a Zone Set
	3.4.7.6 Removing a Zone from All Zone Sets
	3.4.7.7 Changing Zone Types

	3.4.8 Managing Aliases
	3.4.8.1 Creating an Alias
	3.4.8.2 Adding a Member to an Alias
	3.4.8.3 Removing an Alias from All Zones



	Section�4 Managing Switches
	4.1 Displaying Switch Information
	4.1.1 Displaying Hardware Status
	4.1.2 Name Server Data Window
	4.1.3 Switch Data Window
	4.1.4 Port Statistics Data Window
	4.1.5 Port Information Data Window
	4.1.6 Configured Zonesets Data Window
	4.1.7 Alarm Log Data Window

	4.2 Exporting Alarm Log Information to a File
	4.3 Exporting Name Server Information to a File
	4.4 Paging a Switch
	4.5 Resetting a Switch
	4.6 Configuring a Switch
	4.6.1 Switch Configuration
	4.6.1.1 Chassis Name
	4.6.1.2 Switch Administrative States
	4.6.1.3 Domain ID
	4.6.1.4 Broadcast Support
	4.6.1.5 Timeout Values

	4.6.2 Network Configuration
	4.6.2.1 IP Configuration
	4.6.2.2 Remote Logging
	4.6.2.3 SNMP Configuration
	4.6.2.4 SNMP Trap Configuration

	4.6.3 Configuration Backup
	4.6.4 Configuration Restore
	4.6.5 Reinitializing the Configuration File System

	4.7 Archiving a Switch
	4.8 Restoring a Switch
	4.9 Loading Firmware
	4.10 Restoring the Factory Default Configuration

	Section�5 Managing Ports
	5.1 Displaying Port Information
	5.1.1 Monitoring Port Status
	5.1.1.1 Displaying Port Modes
	5.1.1.2 Displaying Port Operational States
	5.1.1.3 Displaying Port Speeds
	5.1.1.4 Displaying Tranceiver Media Status

	5.1.2 Port Statistics Data Window
	5.1.3 Port Information Data Window
	5.1.4 Name Server Data Window

	5.2 Configuring Ports
	5.2.1 Changing Port Administrative States
	5.2.2 Changing Port Speeds
	5.2.3 Changing Port Modes
	5.2.4 Changing TL Modes
	5.2.5 Changing Buffer-to-Buffer Credits
	5.2.6 I/O Stream Guard
	5.2.7 Extending Port Credits
	5.2.8 Resetting a Port

	5.3 Testing Ports

	Appendix�A Command Line Interface
	A.1 Logging On to a Switch
	A.2 Command Syntax
	A.3 Commands
	Admin Command
	Alias Command
	Config Command
	Date Command
	Fallback Command
	Help Command
	History Command
	Image Command
	Lip Command
	Passwd Command
	Ps Command
	Quit Command
	Reset Command
	Set Alarm Clear Command
	Set Beacon Command
	Set Config Command
	Set Log Command
	Set Port Command
	Set Setup Command
	Set Switch Command
	Show Command
	Show Config Command
	Show Log Command
	Show Perf Command
	Show Setup Command
	Shutdown Command
	Test Command
	Uptime Command
	User Command
	Whoami Command
	Zone Command
	Zoneset Command
	Zoning Command


	Glossary
	Index

